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SOLIDWORKS® 2018 Reference Guide Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SOLIDWORKS. On the completion of this chapter, you will
be able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly and Drawing document.
e Utilize the available SOLIDWORKS Design Intent tools:

e Comments, Design Binder, ConfigurationManager, Dimensions, Equations,
Design Tables and Features.

e Identify the correct Reference planes:
e 2D and 3D Sketching.
e Insert sketch Reference planes.
e Comprehend the Parent/Child relationship.
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found and Invalid
Solution Found.

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve,
Point, Centerline, Text, Plane, Route line and Belt/Chain.

e C(lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block and Belt/Chain.

e Recognize and utilize the following Spline tools:
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e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum
Radius and Show Curvature Combs.

e Reuse an existing 2D Sketch.

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SOLIDWORKS definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design
changes occur.

Design for change. Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,
part, assembly and drawing.

w s

“¥" When editing or repairing geometric relations, it is considered best practice to edit
the relation vs. deleting it.

Design Intent in a Sketch ———— e

Build design intent in a sketch as the profile is created. A )
profile is determined from the Sketch Entities. Example: o
Rectangle, Circle, Arc, Point, Slot, etc. Apply symmetry Horizontal R
into a profile through a sketch centerline, mirror entity and o/ i
position about the reference planes and Origin. Always « o
know the location of the Origin in the sketch. o —
Build design intent as you sketch with automatic . : 1 osor
Geometric relations. Document the decisions made during . sy 7re
the up-front design process. This is very valuable when Perpendenter Tonoet

you modify the design later.

A rectangle (Center Rectangle Sketch tool) contains

Horizontal, Vertical and Perpendicular Add Relations -
automatic Geometric relations. T = = T HMH

Apply design intent using added ] £ | colinear

Geometric relations if needed. Example: : i ' J\‘ perpendicsir
Horizontal, Vertical, Collinear, : ;II‘
Perpendicular, Parallel, Equal, etc. | | |
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Example A: Apply design intent to create a square profile.

Sketch a rectangle. Apply the Center Rectangle Sketch tool. 3.00

Note: No construction reference centerline or Midpoint

relation is required with the Center Rectangle tool. Insert o - /‘/’/
dimensions to fully define the sketch. o S
Example B: If you have a hole in a part that must always be | //'?\-\ |
16.5mm < from an edge, dimension to the edge rather than i \“\\

to another point on the sketch. As the part size is modified, -
the hole location remains 16.5mm < from the edge as
illustrated. [ P4

Build design intent into a feature by addressing End
Conditions (Blind, Through All, Up to Next, Up to
Vertex, Up to Surface, Offset from Surface, Up to Body
and Mid Plane), symmetry, feature selection, and the 39.50
order of feature creation.

Design Intent in a Feature JI—(é 6]
1

Example A: The Extruded Base feature remains symmetric
about the Front Plane. Utilize the Mid Plane End Condition
option in Direction 1. Modify the depth, and the feature
remains symmetric about the Front Plane.

Example B: Create 34 teeth in the model. Do
you create each tooth separately using the
Extruded Cut feature? No.

Create a single tooth and then apply the
Circular Pattern feature. Modify the Circular
Pattern from 32 to 24 teeth.

Design Intent in a Part

Utilize symmetry, feature order and reusing
common features to build design intent into a
part. Example A: Feature order. Is the entire
part symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design Intent in an Assembly

Utilizing symmetry, reusing common parts and

using the Mate relation between parts builds the SO OEEI S . 8K
design intent into an assembly. Soocaceccocc@be
Example A: Reuse geometry in an assembly. The EJ 5 E%?OEE;Z EE ﬂﬁ 5o
assembly contains a linear pattern of holes. Insert T e e e o =
one screw into the first hole. Utilize the Component RS NS S g oS
Pattern feature to copy the machine screw to the
other holes.
Design Intent in a Drawing
Utilize dimensions, tolerance and notes in parts and é e
assemblies to build the design intent into a drawing.
Example A: Tolerance and material in the drawing.
Insert an inside diameter tolerance +.000/-.002 into
the Pipe part. The tolerance propagates to the B
drawing.
Define the Custom Property Material in the Part. K "
The Material Custom Property propagates to your
drawing.
w s
“¥" Create a sketch on any of the default planes:
Front, Top, Right or a created plane or face.
H E >

SOLIDWORKS Design _|c®&ee -
Intent tOOIS \%P 2 ([}/Q =

@ Go To...

ISt part (Part2)

3 Hidden Tree Items
Comments * B g pddto Library

.. Equ Open Drawing
Add comments, notes or additional BV et |60 add comment
information to features or sketches during ‘: POt ree Display
the design period. This will aid you or your {1 :gp Document Properties..
colleagues to recall and to better understand P oo onfiguration Publisher-
. . | Apbearance 4
the fundamental design intent of the model
. .. Cemmenﬂ

and individual features later. 05/18/2017 11:21 AM Davepl:

ICUSTOMER ABC

Right-click on the name, feature or sketch in
the FeatureManager. Click Comment » Add
Comment. The Comment dialog box is
displayed.

R & @
Add timestamp
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Enter the information. Click Save and Close. A Comments folder is
displayed in the FeatureManager. Double-click the feature in the
Comments folder to view the comment.

n s
P

You can also add a Date/Time stamp to your comment.

Design Binder

Activate the Design binder. Click Options > System Options
tab > FeatureManager. Select Show from the drop-down menu.
The Design Binder is an embedded Microsoft Word document that
provides the ability for the user to capture a screen image and to
incorporate text into a document.

Design Intent, Sketching and Sketch Entities

® RS @ >

N

@a Part2 (Default<<Default>_Dis

%Comments
@Commenﬂ

G ERS @ >

i

@3 Part2 (Default<<Default>_Dis

v Comments
E Comment1
4 History
Sensors
N Design Binder
% -| Design Journal.doc <E
4 Annotations

ConfigurationManager L
SEW @

When you create various configurations for assemblies,
design tables, etc., use the comment area to incorporate a
comment for these configurations.

Dimensions

Configurations

v % Part1 Configuration(s)

['F@ +/ Defal ®8§ New Exploded View...

Erﬂ New Model Break View...
1a Ad%)erived Configuration..
Show Preview

Properties...

To be efficient, reuse existing geometry. Provide
dimensions with descriptive names.

Equations

SOLIDWORKS provides a completely redesigned dialog box for
creating and editing equations, global variables and dimensions.

Add a comment to the end of an equation to provide clarity for
the future. Use descriptive names and organize your equations to
improve clarity.

w 1

“¥* Create an Excel spread sheet to input your equations into
SOLIDWORKS. Use the Link to external file option.

N

N

Modify

v X 0 2%N

3.57in

S ER S >
¥
@ Part2 (Default<<Default>_Dis
4 Comments
4 History
Sensors
4 @ Design Binder
> Annctations
i Equations
§5 Materia
[r‘ Front P
[r‘ Top Plai
[T‘ Right Pl

Manage Equations...
Sho%ﬁle Properties
Go To...

Hide/Show Tree Items.,|

Equations, Global Variables, and Dimensions

G| & | 3% |« Filter All Fields

Name Value / Equation

| |=Global Variables

"GWidth" = "extrusion” - .8

~ oK

Cancel

"GHeight 9

'GlLength"

"HingeFeature
"PinHoleFeatures

"Velcro"

Import...

Export...

"TensionTop"

TensionTopOffset"

"CableFeed
"CableFeedDistance’

Help

[ Automatically rebuild | © Angular equation units: Degrees v

Link to external file: ‘ C:\Users\Davep\Documents\2015 - 2016 Hand MQP\Final for Hand 4-28-2016\CAD 4-28-2016\Final Equation

[ Automatic solve order

&
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w1

0N . .
You can specify the units of measurement for Global = >
variables, and for the values and equations that define the SER[G[@

global variables. You can define the units in the Equations fﬂ B:ss-;m“ ?

and modify dialog boxes for dimensions, and in - .

PropertyManagers that support equations. — 9
Direction 1 A
7| Blind v

Design Tables i
There are a number of ways to incorporate a comment into a N

design table. One way is to add “SCOMMENT” to the G g
heading of a column. This provides the ability to add a @ SIS {UHIED
comment in a design table. File Properties
|:| Direction 2 v
D Thin Feature v
Features Selcted Contaurs v
Always use descriptive names in the FeatureManager design
tree, not the default feature names such as Boss-Extrudel,
Cut-Extrudel, LPatternl, etc. Group important features
toward the top of the FeatureManager design tree. [ Scrollselected item into view
s Name feature on creation
iy %rrow key navigation

‘¥ Enable the FeatureManager Name feature on Dloynamic highiht

creation option: click Options & > System Options  |Bvs renspsrent tyou estrevanager e in parsassrbies
> FeatureManager > Name feature on creation e festenen e e e

box. The Name feature on creation option highlights
the feature name when created and allows the feature to be
named.

CAllow component files to be renamed from FeatureManager tree

Identify the Correct Reference Planes

Most SOLIDWORKS features start with a 2D sketch. Sketches are the foundation for
creating features. SOLIDWORKS provides the ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch Plane located on a Reference Plane, face or a
created place. 3D sketches are very useful in creating sketch geometry that does not lie on
an existing or easily defined Plane.

Does it matter where you start
sketching? Yes. When you create a
new part or assembly, the three
default planes are aligned with
specific views. The plane you select
for your first sketch determines the
orientation of the part. Selecting the
correct plane to start your model is
very important.

orging Originf Originf]
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2D Sketching/Reference Planes

The three default L reference planes,
displayed in the FeatureManager design tree,
represent infinite 2D planes in 3D space:

e Front.

Right
e Top. Secondary Datum A
e Right. —

Planes have no thickness or mass.
Orthographic projection is the process of
projecting views onto parallel planes with L
projectors. These are the default 1 datum
planes:

e Primary.

Top
Frimary Datum

e Secondary.
e Tertiary.

Use the following planes in a manufacturing
environment:

e Primary datum plane: Contacts the part at a minimum of three points.
e Secondary datum plane: Contacts the part at a minimum of two points.
e Tertiary datum plane: Contacts the part at a minimum of one point.

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration. Remember - the plane
or face you select for the base sketch determines the orientation of the part.

| SR

2D Profile Front Plane Top Plane Right Plane
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The six principle views of Orthographic projection listed in the ASME Y 14.3 2009
standard are Front, Top, Right, Bottom, Rear and Left. SOLIDWORKS Standard view
names correspond to these Orthographic projection view names.

ASME Y14.3 2009 Principle View Name: SOLIDWORKS Standard
View:

Front Front

Top Top

Right side Right

Bottom Bottom

Rear Back

Left side Left

w1

AR ANSI is the default overall drafting standard
used in the book.

N}

as Displayed are the Front, Top, Right and
Isometric views in Third Angle Projection.

Tutorial: Default Reference Planes 4-1

“ ™ D&M ENGINEERING A

Create a New part. Display the default Reference
planes in the Graphics window.

RIGHT ANGLE
A Cran R

|

1. Click New | from the Menu bar. The : ‘
Templates tab is the default tab. Part is the
default template from the New
SOLIDWORKS Document dialog box. v
@D Part1 (Default<<Default>_Dis
2. Click OK. The Part FeatureManager is @) istory
displayed. Use the sketch Origin to understand - oz
. . » Annotations
the (x-,y-) coordinate location of the sketch B35 equations
and to apply sketch dimensions. Each sketch in the part has its £ Material <not specifed
own Origin. m """"
3. Click Front Plane from the FeatureManager design tree. The I[izg;“np'
Front Plane is the Sketch plane. The Front Plane is highlighted in
the FeatureManager and in the Graphics window.
Show the default Reference planes in the Graphics window. Select
the Front, Top and Right planes.
4. Hold the Ctrl key down. 1 L
5. Click Top Plane and Right Plane from the FeatureManager
design tree.
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6. Release the Ctrl key % Part1 (Default<<Default>_Display
. . H\'stow
7. Right-click Show ® from the Context toolbar. [ sensors
. . . . . 4 Annotations
8. Click inside the Graphics window. The three planes are [ Equations
displayed in the Graphics window. Note the Plane icon in the ~_ 5 Materil <not specified>
FeatureManager. AR
e
“¥" Rename a feature or sketch for clarity. Slowly click the

feature or sketch name twice and enter the new name when the =
>
old one is highlighted. $ B & @

Rename the default Reference planes. G partt Default<<Default> Display
9. Rename the Front Plane to Front-PlateA. “"Stw

Sensors
10. Rename the Top Plane to Top-PlateB. » [A] Annotations
11. Rename the Right Plane to Right-PlateC. T

2% Material <not specified>
12. Rebuild @ the model. | B

g Top PlateB
13. Close the model. B Right Platec

I_. QOrigin

3D Sketching/Reference Planes

Create a 3D Sketch in SOLIDWORKS. A 3D Sketch is typically
used for advanced features such as Sweeps and Lofts or when the
sketch does not lie on an existing or easily definable plane. Most
basic features are created from a 2D Sketch.

There are two approaches to 3D Sketching. The first approach is
called 2D Sketching with 3D Sketch planes. In this approach, you:

1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you are required to move
sketch entities to create a 3D sketch.

Using the 2D Sketching with 3D Sketch planes approach provides
the ability to:

e Add relations:
e Between planes.
e Between sketch entities on different planes.
e To planes.
e Define planes.

e Move and resize planes.
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Tutorial: 3D Sketching 4-1

5% i it V)
Create a simple 3D Sketch on plane using the line sketch tool. e SOL’DWOR; 2‘; Eme
1. Create a New [ part. Use the default ANSI Part template. si;t 0O,
~ D\menswon
2. Click Top Plane from the FeatureManager. e ©-0
{__ “Sketch
3. Click the Sketch tab from the CommandManager. G o serch
4. Click 3D Sketch On Plane from the Sketch Consolidated %D i
toolbar as illustrated. 3DSketchl is active. @ Part2 (Default<<Default> Display
History
5. Click the Line 7 Sketch tool. (%] Sensors
. . .. » Annotations
6. Sketch a vertical line through the Origin. il Eauscions
. . . C §5 Material <not specified>
7. Right-click Exit Sketch ‘£ from the o & J_ [ Frontpane
Context toolbar. 3DSketchl is displayed | #[2IW#~
in the FeatureManager and is under I selec ) [] Right Plane
defined P I I

8. Close the model.

Tutorial: 3D Sketching 4-2

Create the illustrated model. Insert two features: Boss-Extrudel
and Cut-Extrudel. Apply the 3D Sketch tool to create the
Cut-Extrudel feature. System units = MMGS.

1. Create a New | ] part in SOLIDWORKS. Use the default
ANSI, MMGS Part template.

2. Right-click Front Plane from the FeatureManager. This is

your Sketch plane. Origin

3. Click Sketch {_ from the Context toolbar. The Sketch
toolbar is displayed. S\ rom——

4. Click the Corner Rectangle I tool from the Consolidated (%] Equations
Rectangle Sketch toolbar. The PropertyManager is % Fepd
displayed. '

) o [1| wrunt Plane)

5. Sketch a rectangle as illustrated. The part Origin is located (1) {Gp 30 Sketch On Plane
in the bottom left corner of the sketch.

Insert dimensions. i 48 i

6. Right-click Smart Dimension & from the Context =
toolbar.

7. Dimension the sketch as illustrated. The sketch is
fully defined. The sketch is displayed in black.
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Create the first feature for the model. The Extruded Boss/Base
feature adds material to a part. Extrude the sketch to create the first
feature. Apply symmetry.

8. Click Extruded Boss/Base @ from the Features toolbar.

9. Select the Mid Plane End Condition in Direction 1. Enter
100.00mm for Depth in Direction 1. Accept the default

conditions. Click OK ¥ from the Boss-Extrude
PropertyManager.

w1

“¥" The Instant3D tool provides the ability to drag geometry and
dimension manipulator points to resize features or to create new
features directly in the Graphics window. Click the face. Select a
manipulator point. Click and drag. Click a location along the ruler
for the required dimension. The rule increments are set in System
Options.

10. Create 3DSketchl. 3DSketchl is a four point sketch. Click 3D
Sketch On Plane from the Consolidated Sketch toolbar as
1llustrated.

11. Click the Line e Sketch tool. 3DSketchl is a four point

sketch as illustrated. 3DSketchl is the profile for Cut-Extrudel.

12. Locate the first point of the sketch. Click the back right
bottom point as illustrated. Locate the second point of the
sketch. Click the top left front point as illustrated. Locate the
third point of the sketch.

13. Click the bottom right front point as illustrated.

Locate the fourth point of the sketch.
14. Click the back right bottom point as illustrated to close the
sketch.

Create the Cut-Extrudel feature.
15. Click Extruded Cut @ from the Features toolbar.

Page4-11
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S E RS @
@) Bogs-Extrude ®@
e

From AN

Sketch Plane v

o~ ~

Direction 1

Mid Plane

i

£y 100.00mm

[ Thin Feature

v

Draft outward

Selected Contours

Sketch
Dimension

C Sketch

(30 3D sketch
WD 3D Sketch On Plane
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16. Click the front right vertical edge as illustrated to remove
the material. Edge<1> is displayed in the Direction of
Extrusions box.

17. Click OK ¢ from the Cut-Extrude PropertyManager.
Cut-Extrudel is displayed in the FeatureManager.

18. Close the model.

w1

“¥" Select the front right vertical edge or the Top face to remove
the required material in this tutorial.

The second approach to create a 3D Sketch in SOLIDWORKS is

3D Sketching. In this approach: T e e
1. Open an existing 3D Sketch. T

. 3D Sketching 4-3 (Default<<Default
2. Press the Tab key each time you need to move your sketch ©

entities to a different axis. ls:zs
The sketch origin is placed wherever you start the sketch. > [AlAmnotations
Equations
Tutorial: 3D Sketching 4-3 5} Material <nof speciicd>
Apply the 3DSketch tool to create a 3DSketch using the Tab {11 ::;2:&
key to change Sketch planes. L' e

1. Open 3D Sketching 4-3 from the SOLIDWORKS 2018
folder.

Edit the 3D Sketch.
2. Right-click 3DSketch from the FeatureManager.

3. Click Edit Sketch = from the Context toolbar.
3DSketchl is displayed in the Graphics window.

4. Click the Line / Sketch tool. Note: The mouse %
feedback icon. XY
5. Click the right endpoint of the sketch as
illustrated.

6. Press the Tab key to change the Sketch plane
from XY to YZ. The YZ icon is displayed on the

mouse pointer. ‘
7. Sketch a line along the Z axis approximately s
130mm as illustrated. /jﬁ T

8. Press the Tab key twice to change the sketch
plane from YZ to XY. The XY icon is displayed
on the mouse pointer.
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9. Sketch a line back along the X axis approximately
30mm. f(‘(s.w
Nz

10. Sketch a line on the Y axis approximately 30mm. b
11. Sketch a line along the X axis of approximately 130mm.
Deselect the Line Sketch tool.
12. Right-click Select. View the 3D Sketch.
13. Rebuild 8 the model.
14. Close the model.
Tutorial: 3D Sketching 4-3A S
Apply the circle sketch tool to create a Sweep along a 3D & B 30 Sketching 4-3A (Default<<D
SketCh. 4 H\'stow
Sensors
1. Open 3D Sketching 4-3A from the SOLIDWORKS > [&l Annotatons
2018 folder. s
2= Material <not specified>
Create the 2D sketch. ‘: i
2. Right-click Right Plane from the FeatureManager. i\ﬁﬁ °Ld
Click Sketch. E e o w

3
4. Display a Right view.
5. Sketch a circle at the
origin as illustrated. \L "'@
Create a Swept Boss feature.
6. Click Swept Boss/Base > — -
DS SOLIDWORKS | File Edit View Insert Tools Window Help A

from the Features [ : @
d @ 3 f Swept\Boss/Base
CommandManager. Bitruded  Revolved Swept Boss/Base

[EEEsD EEERE Sweeps a closed profile along an

7. Clle the Circular open or closed path to create a solid
Features

Sketch | Evaluate feature.

Profile box.
8. Epter.lOin for ¢ BERSS
diameter. & sweep Q)
9. Click the 3D Sketch Path(3DSketch) v
. . rofile and Path A
(\513533)\13 the graphlcs i OSk:tcth Profile

@ Circular Profile

10. Click OK. View the c =
results in the graphics @ 0.0in ]
Wll’ldOW. Options.

11. Close the model.

[ Thin Feature

Curvature Display v
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Tutorial: 3D Sketching 4-4

Utilize the 3D Sketch placement method. Insert a hole on a
cylindrical face using the Hole Wizard.

1. Open 3D Sketching 4-4 from the SOLIDWORKS 2018
folder. Note: With a 3D sketch, press the Tab key to move
between planes.

2. Click the Hole Wizard & feature tool.

Create a Counterbore, ANSI Inch, Socket Head Cap Screw
fastener Type. Size - Y. Fit - Normal. End Condition -
Through All with a .100in Head clearance.

4. Click the Positions Tab.

5. Click the 3D Sketch button. The Hole Position
PropertyManager is displayed. SOLIDWORKS displays an

active 3D interface with the Point XY « tool.

w 1

“¥" When the Point tool is active, wherever you click, you will
create a point.

Dimension the sketch.

6. Click the cylindrical face of the model as illustrated.
The selected face is displayed in orange. This indicates
that an OnSurface sketch relations will be created
between the sketch point and the cylindrical face. The
hole is displayed in the model.

7. Insert a .25in dimension between the top face and the
sketch point.

Locate the point angularly

around the cylinder. Apply

construction geometry.

8. Display the Temporary
Axes.

Page 4 - 14
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S ER S @
@ Hole Specification
v X

7T Type % Positions

Favorite

Hole Type

i
i)

hif

Standard:

/ BB

ANSI Inch

/.

Type:
Socket Head Cap Screw
Hole Specifications
Size:

1/4

Fit:

/

<

/

Normal

[Jshow custom sizing

End Condition

e Through All

Options
w Head cw
I‘EE 0.100in :

/

©)

>
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9. Click the Line e Sketch tool. Note: 3D Sketch is still
activated.

10. Ctrl + Click the top flat face of the model. This moves
the red space handle origin to the selected face. This also
constrains any new sketch entities to the top flat face.

Note the mouse pointer # < icon.

11. Move the mouse pointer near the center of the activated
top flat face as illustrated. View the small black circle. The
circle indicates that the end point of the
line will pick up a Coincident relation.

12. Click the center point of the circle.

13. Sketch a line so it picks up the AlongZ
sketch relation. The cursor displays the
relation to be applied. This is a very
important step.

Deselect the Line Sketch tool. podliSetons ~
14. Right-click Select.

15. Create an AlongY sketch relation
between the center point of the hole on
the cylindrical face and the endpoint of
the sketched line. The sketch is fully
defined.

16. Click OK ¢ from the
PropertyManager.

17. Click OK ¥ to return to the Part
FeatureManager.

18. Expand the FeatureManager and view
the results. The two sketches are fully
defined. One sketch is the hole profile,
the other sketch is to define the position
of the feature.

19. Close the model.

w1

A Create a second sketched line and insert an angle dimension
between the two lines. This process is used to control the position of
the center point of the hole on the cylindrical face as illustrated.

Insert an AlongY sketch relation between the center point of the hole

on the cylindrical face and the end point of the second control line.
Control the hole’s position with an angular dimension.
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w1

“¥" The main advantage of the 3D Sketch placement method is that it can place a set of
holes on any set of solid faces, regardless of whether they are at different levels, or are
non-parallel. A limitation: 3D sketches can be fairly cumbersome and difficult. See
section on 3D Sketching in SOLIDWORKS Help for additional details.

2D Sketching/Inserting Reference Planes w | U e
Reference Planes are geometry created from existing planes, faces, ooty JISEAER
vertices, surfaces, axes, and or sketch geometry. To access the Plane | g'% .
PropertyManager, click Insert » Reference Geometry » Plane from A::e

the Menu bar or click the Plane i tool from the Consolidated

Reference Geometry Features toolbar.

)—r Coordinate System
@ Point

@ Center of Mass
ﬂ Mate Reference

Plane Tool
The Plane ¥ tool uses the Plane EEEREC C ER ¢ &
PropertyManager. The Plane il Plane @ | | @ Plane @
PropertyManager provides the following v X = v X =
selections: Message ~ | |Message ~
o First Reference. Select a face, plane or | et references and constraints | il cefined
edge to create a reference plane. These | =t Reference | [T Reference i
options are available: @ @ [Fece<t>
. Second Reference ~ \\ Parallel
e Reference Entities. Displays the ] rerpendicuar
selected planes either from the al _p _
FeatureManager or from the Third Reference ~ Aﬁ comedent
Graphics window. ] o e =
:
e Parallel. Creates a plane parallel to | ©ptiens ~ [ Fip offset
the selected plane. For example, Al £ -
select a face for one reference and a =] vid Plane
point for another reference. The — —
created plane is parallel to the face
and coincident to the point. o
Third Reference A
e Perpendicular. Creates a plane perpendicular to the all
selected reference. For example, select an edge or curve for
one reference and a point or vertex for another reference. °"“°£F”p - -~
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e Coincident. Creates a plane S ER e EBEEER
through a point coincident to a (i Plane @ | | @ Plane @
plane or a face.

v X~ v X -

e Project. Projects a singular entity Message ~ | [Message ~
such as a point, vertex, origin, or Select references and constraints Fully defined
coordinate system onto a non-planar | First Reference ~ | | First Reference ~
surface. Select the sketch pointand | @ | || @ [Fece<t
the model surface. Two options Second Reference - parallel
appear in the PropertyManager: all Perpendicular
e Nearest location on surface. Tl e ~ Concident

90deg

e Along sketch normal. ol o —

e Tangent. Creates a plane tangent to o"tionsm U B [ Flip offset
cylindrical, conical, non-cylindrical, - e 1 =
and non-planar faces. Select a =/ Mid Plane
surface and a sketch point on the e —
surface. The plane is created tangent @ I:|
to the surface and coincident to the sketch point. —

e At Angle. Select a plane or planar face and select an edge, | @ [}
axis, or sketch line. You can specify the number of planes options -
to create. Enter the angle value in the angle box. [ Fiip normal

e Offset Distance. Creates a plane parallel to a plane or face, =
offset by a specified distance. You can specify the number of %Pew ®
planes to create. Enter the Offset distance value in the v X
distance box. Message —5
e Reverse direction. :””i ‘:::"ed .

Reverses the direction of the o=~
angle if required. N[

e Numbers of Planes to Perpendicular
Create. Displays the A coincident
selected number of planes. 58] sodeg

™ /0.100in

e Mid Plane. Creates a mid-plane 2 i Plane
between planar faces, reference cocond Referenca —
planes, and 3D sketch planes. . o
Select Mid Plane for both | erpendicutr
references. Coimcidont

|| Project

Third Reference

0! I:
Options v
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Tutorial: Reference Plane 4-1 =
: : : S ERISI@
Create three Reference planes using the Offset Distance option from @ o ®
the Plane PropertyManager. e
1. Create a New ] part. Use the default ANSI Part template. : X
Set system units to MMGS. _— -
Fully defined
2. Display an Isometric view. First Reference ~
3. Right-click Top Plane from @ [Top Plane
the FeatureManager design | Parallel
tree. ‘é% : J_ Perpendicular
4. Hold the Ctrl key down. - A coincident
5. Click and drag the L | (] [90.00deg -
boundary of the Top Plane - - 25.00mm ~
upwards in the Graphics - O Fip offset
window. The Plane L o 3 X
PropertyManager is = Mid Plane
displayed. Top Plane is displayed in the First Reference box. | .
6. Release the Ctrl key and mouse pointer. ] |
7. Enter 25mm in the Distance. The Plane is offset by Third Reference ~
25mm. Q I
8. Enter 3 in the Number of planes to create box. P

9. Click OK ¥ from the Plane PropertyManager.
Planel, Plane2 and Plane3 are created and
displayed in the Graphics window. Each Plane is
offset from the Top Plane a distance of 25mm.

10. Close the model.

Tutorial: Reference Plane 4-2

Use the Plane PropertyManager to create two angled

Reference planes from an edge at a 45 degree angle.

1. Open Reference Plane 4-2 from the
SOLIDWORKS 2018 folder.

2. Click Right Plane from the FeatureManager
design tree.

3. Click Insert > Reference Geometry > Plane from
the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

4. Click the At angle button.
5. Enter 45deg for Angle.
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6. Click the front vertical edge of Extrudel as illustrated. Do not select the midpoint.
Edge<1> is displayed in the Selections box. The model is fully defined.

7. Enter 2 in the Number of planes to create box.

8. Click OK ¥ from the Plane PropertyManager. Planel and Plane2 are displayed in

the FeatureManager and in the Graphics window.

9. Close the model.

Tutorial: Reference Plane 4-3

Use the Plane PropertyManager to

create a Reference plane using

three vertices (Coincident) to the

Extrudel feature.

1. Open Reference Plane 4-3
from the SOLIDWORKS
2018 folder.

2. Click Insert > Reference
Geometry > Plane. The
Plane PropertyManager is
displayed.

3. Click three Vertices as
illustrated. Vertex<1>,
Vertex<2> and Vertex<3> are displayed in the Reference
Entities boxes. The model is fully defined.

4. Click OK ¥ from the
Plane PropertyManager.
The angled Planel is
created and is displayed
in the FeatureManager
and the Graphics
window.

5. Close the model.

w 1

“¥" Fully define all sketches in the model. However, there are
times when this is not practical, generally when using the
Spline tool to create a complex freeform shape.
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Tutorial: Reference Plane 4-4

Use the Plane PropertyManager to create a Reference plane
parallel to an existing plane, through a selected point.

1.

Open Reference Planes 4-4 from the SOLIDWORKS 2018
folder.

Click the Plane # tool from the Consolidated Reference
Geometry Features toolbar. The Plane PropertyManager is
displayed.

Click the front top right vertex.

Click the Right Plane from the fly-out FeatureManager. The
model is fully defined.

Click OK ¥ from the Plane PropertyManager. Planel is
created and is displayed in the FeatureManager and Graphics
window. Clese the model.

SOLIDWORKS® 2018 Reference Guide

~

Instant3D

LR

Reference | Curves

Geometry

Plane
i .
;7 Axis
J—» Coordinate System
@ Point
S Center of Mass

dm Mate Reference

S

A

Parent/Child Relationship

A Parent feature or sketch is an existing feature or sketch on which others depend.
Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which
rounds the edges.

When you create a new feature or sketch which is based on other features or sketches,
their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is
the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

View the Parent/Child relationship in an assembly for a
feature and a sketch from a component.
1.

Open the AirCylinder Linkage assembly from the
SOLIDWORKS 2018\Solutions folder.

Expand RodClevis<1> from the AirCylinder Linkage
assembly FeatureManager.

Click Base-Extrude. View the information in the
FeatureManager. Right-click Base-Extrude.

Click Parent/Child. The Parent/Child Relationships
dialog box is displayed. View the Sketch2
relationships.

Click Close from the Parent/Child Relationships

~ @ RodClevis<1> (Defaul

4 Mates in AirCylinc

History
Sensors

» Annotations
Equations

O m—
23 Material <not spe

[:‘ Front
[:‘ Top
[ Right

I_,Origin

4 Cut-Extrude3 <+—Sketchs ———

|
4 Cut-Extruded <—Sketch7 ———
@) Chamfer2 DUNNENEN S—

4 Cut-Extrude5 4—?—/

» {8 As3054<1> (Default< v

™

> *Isometric

dialog box.
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View the Parent/Child Relationships for a feature. -

6. Right-click Sketch2 from Base-Extrude in the | ®Pren/chi Reationship: x
FeatureManager design tree. Eiur o s

7. Click Parent/Child. View the Base-Extrude [L'.Z‘J;t ) e bxuce
feature relationships.

8. Click Close from the Parent/Child
Relationships dialog box.

9. Close the model.

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status
bar at the bottom of the SOLIDWORKS window. There are five sketch states in

SOLIDWORKS:

w1
AT

Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager

displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black). The FeatureManager displays no

symbol before the Sketch name.

3. Over Defined. Duplicate dimensions and or relations, (orange -red). The
FeatureManager displays a (+) symbol before the Sketch name. The What’s Wrong

dialog box is displayed.

4. Invalid Solution Found. Y our sketch is solved but results in invalid geometry; for
example, a zero length line, zero radius arc or a self-intersecting spline (yellow).

5. No Solution Found. Indicates sketch geometry that cannot be resolved, (Brown).

w1

‘¥ SketchXpert is designed to assist in an over defined state of a
sketch. SketchXpert generates a list of causes for over defined
sketches. The list is organized into Solution Sets. This tool enables
you to delete a solution set of over defined dimensions or
redundant relations without compromising your design intent.

A Click Options & » System Options > Sketch, and click
the Use fully defined sketches option to use fully defined sketches
for created features.
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A Apply dimensions and relations calculated by the SOLIDWORKS application to

fully define sketches or selected sketch entities. Use the Fully Defined Sketch

PropertyManager.

Sketch Entities

Sketch entities provide the ability to create lines,
rectangles, parallelograms, circles, etc. during the
sketching process. To access the available sketch
entities for SOLIDWORKS, click Tools > Sketch
Entities from the Menu bar menu and select the
required entity. This book does not go over each
individual Sketch entity in full detail but will

@ Ellipse

G Partial Ellipse

U Parabola

m Conic

N Spline

N Style Spline

@ Spline on Surface

ﬁ Equation Driven Curve
@ Point

d."p Centerline

\ Midpoint Line

/ Line

[1 Corner Rectangle

E Center Rectangle

Q 3 Point Corner Rectangle
@ 3 Point Center Rectangle
H Parallelogram

Straight Slot
Centerpoint Straight Slot
' 3 Point Arc Slot

Centerpoint Arc Slot

A Text...

4 Plane

address the more advanced entities.

To obtain additional information of each sketch
entity, activate the sketch entity and click the

question mark @ icon located at the top of the

Customize Menu

@ Polygon
@ Circle

Q Perimeter Circle
0 Centerpoint Arc

entity PropertyManager or click Help »
SOLIDWORKS Help Topics from the Menu bar
and search by using one of the three available tabs:
Contents, Index, or Search.

Line Sketch Entity

The Line Sketch entity >’ tool provides the ability to sketch
multiple 2D lines in a sketch. The Line Sketch entity uses the
Insert Line PropertyManager. The Insert Line PropertyManager
provides the following selections:

e Orientation. The Orientation box provides the following
options:

e As sketched. Sketch a line in any direction using the
click and drag method. Using the click-click method,
the As sketched option provides the ability to sketch a
line in any direction, and to continue sketching other
lines in any direction, until you double-click to end your
process.

e Horizontal. Sketch a horizontal line until you release
your mouse pointer.

_D Tangent Arc
£™) 3 Point Arc
¢ ERSC @
/ Insert Line @
v X
Message ~

Edit the settings of the next new line
or sketch a new line.

Orientation A
@ As sketched
O Horizontal
O Vertical
O Angle
Options ~
[ For construction
[Cinfinite length
D Midpoint line

e Vertical. Sketch a vertical line until you release your mouse pointer.

e Angle. Sketch a line at an angle until you release your mouse pointer.
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e Options. The Options box provides three line types:

¢ For construction. Converts the selected sketch entity to
construction geometry.

¢ Infinite length. Creates a line of infinite length which you
can later trim in the design process.

e Midpoint line. Create a line that is symmetrical from the
midpoint of the line.

e Parameters. You can specify any appropriate combination of

Orientation 2
OAS sketched
@ Horizontal
OVem'caI
OAng\e
Options ~
|:| For construction
|:| Infinite length
DM\'dpo\'nt line

Parameters 2

Nl R

|‘i" 0.00°

the following parameters (or Additional Parameters) to define
the line if the line is not constrained by relations. When you
change one or more parameters, the other parameters update
automatically.

w s

“¥" Use Construction geometry to assist in creating your sketch entities and geometry

that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a

centerline.

Rod
“¥" The plane or face you select for the Base sketch determines the o
part.

Rectangle and Parallelogram Sketch Entity

The Rectangle Sketch entity §’ tool provides the ability to sketch a
Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle and a
3 Point Center Rectangle. The Parallelogram Sketch entity provides
the ability to sketch a Parallelogram.

The Rectangle and Parallelogram Sketch entity uses the Consolidated
Rectangle PropertyManager. The Rectangle PropertyManager
provides the following selections:

e Rectangle Type. The Rectangle Type box provides five
selections:

e Corner Rectangle. Sketch a standard rectangle at a corner
point. Click to place the first corner of the rectangle, drag, and
release when the rectangle is the correct size and shape.

rientation of the

9 BERS@
[ Rectangle @

Rectangle Type A

B =
o @ A

D Add construction lines

Parameters 2
o 0.00

o, 0.00

o, 000
o 000
oy 000

o 0.00

e Center Rectangle. Sketch a rectangle at a center point. Click to define the center.
Drag to sketch the rectangle with centerlines. Release to set the four edges.

¢ 3 Point Corner Rectangle. Sketch a rectangle at a selected angle. Click to define

the first corner. Drag, rotate, and then release to set the length

and angle of the

first edge. Click and drag to sketch the other three edges. Release to set the four

edges.
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¢ 3 Point Center Rectangle. Sketch a rectangle with a center
point at a selected angle. Click to define the first corner.
Drag and rotate to set one half the length of the centerlines.
Click and drag to sketch the other three edges and
centerlines. Release to set the four edges.

e Parallelogram. Sketch a standard parallelogram. A
Parallelogram is a rectangle whose sides are not horizontal
or vertical with respect to the sketch grid. Click to define
the first corner. Drag, rotate, and then release to set the
length and angle of the first edge. Click, rotate, and drag to
set the angle and length of the other three edges. Release to
set the four edges.

e Add construction lines. Converts the entities to construction
geometry.

e From Corners. Adds centerlines from corner to corner.

e From Midpoints. Adds centerlines from midpoint of line
segments.

e Parameters. Specify the appropriate combination of parameters
to define the rectangle or parallelogram if they are not
constrained by relations.

Slot Sketch Entity

The Slot Sketch entity ‘S" tool provides the ability to sketch a
Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a
Centerpoint Arc Slot from the Consolidated Slot toolbar.

The Slot Sketch entity uses the Consolidated Slot PropertyManager.
The Slot PropertyManager provides the
following selections:

e Slot Type. The Slot Type box provides
four selections:

e Straight Slot. Sketch a three point

slot. o o

! / g
e Centerpoint Straight Slot. . & .
Sketch a three point slot located ] / / ]

at an Origin or centerpoint.

e 3 Point Arc Slot. Sketch a four point

arc slot. [L_ §
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Rectangle Type

2
1-0 7
y & A
%Add construction lines

@ From Corners

O From Midpoints
Parameters
o, 0.00
°, | 0.00

[ 0.00
o, 0.00
o 1 0.00
s, 0.00
o, 0.00

o, 0.00

@ ER[o[@

Slot

v

Slot Types

3 3
1 2 12

a a

|:|Add dimensions
= 3
Options
I:‘ For construction
Parameters
(e 0.00mm
(;v 0.00mm

@ 0.00001mm

=
8 0.0000Tmm
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Centerpoint Arc Slot. Sketch a four point arc slot
located at an Origin or reference point. RS51 287

Add dimensions. Insert dimensions as you sketch
the slot.

-

)

Center to Center. Insert center to center dimension
if the Add dimensions box is checked.

I:‘Add dimensions

Overall Length. Insert overall length if the Add

dimensions box is checked. =) |
Parameters. Provides the ability to specify the appropriate on Ceair o Cet”tetf_ ~
combination of parameters to define slot if they are not N —
constrained by relations. The parameters box provides the =, 00omm

following options: Center X Coordinate, Center Y
Coordinate, Radius of Arc, Angle of Arc, Slot Width, Slot
Length.

(o“v 0.00mm
@ 0.00001Tmm
=
o

0.00001Tmm

Tutorial: Slot Sketch - Instant3D 4-1

Utilize the Slot Sketch tool. Create an Extruded Boss/Base and
Extruded Cut feature using the Instant3D tool.

1.

Create a New | part. Use the default ANSI, IPS Part
template. ‘%@ _\ . l:rmvue
Right-click Front Plane from the FeatureManager. Straight Slot

. #— Centerpoint Straight Slot
Click Sketch \— from the Context toolbar. The Sketch @ 3 Point Arc Slot

toolbar is dlsplayed Centerpoint Arc Slot
Click Centerpoint Straight Slot @ from the

Consolidated Slot toolbar as illustrated. The Slot
PropertyManager is displayed. If needed, uncheck

the Add dimension box. e

. . ' !
Click the Origin. e ic o A
Click a position directly to the right of the Origin. / /
Click a position directly above the second point as Origin )
illustrated.

Dimension the slot sketch.

8.

Right-click Smart Dimension € from the .
Context toolbar in the Graphics window. Origin

Dimension the model as illustrated. The \\ l_ RS0
sketch is fully defined. Note the location of <+— .......... +
the Origin.
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Apply the Instant3D tool. Create an Extruded Boss/Base feature. The
Extruded Boss/Base feature adds material to a part. Note: Edit the ‘WY P
feature, and view the PropertyManager to confirm that you picked Reference Curves Instant3D
the correct dimension with the on-screen ruler. The Instant3D tool oeometry

does not provide various End Conditions for Design Intent.

Exit Sketchl.

10. Right-click Exit Sketch & Note: Instant3D
is active by default. If needed click Instant3D
from the Features tab.

11. Display an Isometric view.

Create an Extruded Boss/Base feature with a

default Blind End Condition.

12. Click the top edge as illustrated. A green
arrow is displayed. Drag the arrow forward
and click the on-screen ruler approximately
0.25in.

13. View Boss-Extrudel in the FeatureManager. Lo ~
14 Blind hd

. Edit Boss-Extrudel in the FeatureManager.

by
15. Enter Depth = .30in. Click OK + from the I‘
PropertyManager. &%.3 00 —
Create an Extruded Cut feature using Instant3D. =

16. Display a Front view.

Draft outward

17. Right-click the Front face. This is your Sketch plane.

18. Click Sketch _ from the Context toolbar. The Sketch toolbar
is displayed.

19. Click the Circle ©) Sketch tool.

20. Sketch a circle centered at the Origin as illustrated.

Exit the Sketch.
21. Right-click Exit Sketch. Display an Isometric view.

Create an Extruded Cut feature.
22. Click the circumference of the sketch as illustrated.

23. Click and drag the arrow backwards to create a hole in the
model. Note: The default End Condition is Blind.

24. Release the mouse icon behind the model. The Cut-Extrudel
feature is displayed. View the model.

25. Close the model.
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Polygon Sketch Entity

SIERS @
The Polygon Sketch entity ZF}’ tool provides the ability to create | Pelygen ®
equilateral polygons with any number of sides between 3 and &
40. The Polygon Sketch entity uses the Polygon Options A
PropertyManager. The Polygon PropertyManager provides the L] For construction
following selections: Parameters ~
® © :

o Existing Relations. The Existing Relations box displays

. . .. . nscribed circle
information on existing relations of the polygon sketch. ©

O Circumscribed circle

e Add Relation. The Add Relation box displays the selected G 00
relations to the points and lines of your polygon sketch. &

0.00

fry O ‘6.81909767
“¥* You cannot add a relation to a complete polygon. You can i~
only add a relation to the points and lines of the polygon.

€ > <> <> <« >

0.00°

New Polygon
e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected sketch entity to construction geometry.

e Parameters. The Parameters box provides the ability to

specify the appropriate combination of parameters

to define the polygon. When you modify or =

change one or more parameters, the other // —"

parameters update automatically. The available / AN

selections are: / » . l>

e Number of Sides. Sets the number of sidesin [ L \
your polygon. ‘ H ) }K

. /

e Inscribed circle. Selected by default. Displays \ » K
an inscribed circle inside the polygon. This \\ — Vi
option defines the size of the polygon. The e
circle is construction geometry.

e Circumscribed circle. Displays a circumscribed — "'\-\:\
circle outside of the polygon. This option defines the / N
size of the polygon. The circle is construction / ®» q
geometry. ' L }

e Center X Coordinate. Displays the X coordinate \ | |
for the center of your polygon. \ » /.z

AN P B
—_— -
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e Center Y Coordinate. Displays the Y coordinate
for the center of your polygon.

e Circle Diameter. Displays the diameter of the
inscribed or circumscribed circle.

e Angle. Displays the angle of rotation.

e New Polygon. Creates more than a single polygon
without leaving the PropertyManager.

Tutorial: Polygon 4-1

Create a new part using the Polygon Sketch entity.

1. Create a New L] part. Use the default ANSI Part
template.

2. Right-click Top Plane from the FeatureManager
design tree. This is your Sketch plane.

3. Click Sketch & from the Context toolbar. The Top
Plane boundary is displayed in the Top view.

4. Click the Cirele & Sketch tool. The Circle
PropertyManager is displayed.

5. Sketch a circle centered at the origin.

Insert a polygon.

6. Click Tools > Sketch Entities > Polygon from the

Menu bar or click Polygon from the Sketch toolbar.
The Polygon PropertyManager is displayed.

7. Sketch a Polygon centered at the Origin larger than
the circle as illustrated.

8. Click OK ¥ from the Polygon PropertyManager.

9. Rebuild 9 the model. View the created Polygon in

the Graphics window.
10. Close the model.

“¥* For illustration purposes, the Reference planes and
grid are hidden.
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Circle Sketch and BIEIREL BEEE
Perimeter Circle Sketch O circle @ || O cirele ®
Entity ’ Y
Circle Type A | | Circle Type A
The Circle Sketch and Perimeter Circle m O
Sketch entity %’ tool provides the ability . il e ~
to control the various properties of a For construction L
CirCIG. Parameters A
The Circle Sketch and Perimeter Circle ey @ Under Defined
Sketch entity uses the consolidated Circle |® % Add Relations ~
PropertyManager. The consolidated Circle |/ 003937008 X [Fix
PropertyManager provides the following Options ~
SelectionS: [JFor construction
Parameters Lo
e Circle Type. Provides the ability to select either a center @ .
based circle or a perimeter-based circle sketch entity. o z
o Existing Relations. The Existing Relations box provides the IR 0

following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

e Options. For construction. Not selected by default. Converts
the selected entity to construction geometry.

e Parameters. Specifies the appropriate combination of
parameters to define the circle if the circle is not constrained
by relations. The available selections are:

e Center X Coordinate. Sets the Center X Coordinate
value.

e Center Y Coordinate. Sets the Center Y Coordinate
value.

e Radius. Sets the Radius value.
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The Perimeter Circle Sketch entity provides the ability to define
a circle using 3 points along its perimeter. This sketch entity is
very useful when you are not concerned about the location of the
center of the circle.

Tutorial: Perimeter Circle 4-1
Create a Perimeter Circle sketch.

1. Create a New | ] part. Use the default ANSI Part template.

2. Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

3. Click Sketch  from the Context toolbar. I

4. Click the Line e Sketch tool. The Insert Line
PropertyManager is displayed.

5. Sketch two lines as illustrated.

Sketch a circle that is tangent to both lines. ORV- &

6. Click Perimeter Circle from the Consolidated Circle ~ () ircle
Sketch toolbar. The Circle PropertyManager is &) perimeter Circle
displayed.

7. Click each line once.

8. Click a position as illustrated to determine the size of Ke)
the circle. The X coordinate, Y coordinate, and Radius
are displayed in the Parameters box. The two lines are
tangent to the circle. You created a simple circle using
the Perimeter Circle sketch entity.

9. Click OK ¥ from the Circle PropertyManager. View ? L
the model.

10. Rebuild 9 the model.
11. Close the model.

w1

“¥" If the two lines change, the circle remains tangent to
the llneS Line length measured between virtual sharps in 3d

L Enable spline tangency and curvature handles

AR In System Options, under the Sketch folder, apply Shost image on drsg
the Ghost image on drag option. The option displays a %Showmam comb bounding curve

ghost image of a sketch entities' original position while [ scale sketch on first dimension creation
you drag the SketCh in the GraphiCS WindOW. [CJEnable on screen numeric input on entity creation

I:‘ Show spline control polygon by default
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Centerpoint Arc Sketch
Entity

The Centerpoint Arc Sketch entity & tool
provides the ability to create an arc from
a center point, a start point, and an end
point. The Centerpoint Arc Sketch entity
uses the consolidated Arc
PropertyManager.

The Arc PropertyManager controls the
properties of a sketched Centerpoint Arc,
Tangent Arc and 3 Point Arc.

The consolidated Arc PropertyManager
provides the following selections:

e Arc Type. Provides the ability to
select a Centerpoint Arc, Tangent Arc
or 3 Point Arc sketch entity.

Design Intent, Sketching and Sketch Entities

S ERo[@ |[CSERS@

N Arc @ || ™ Arc ®
v v

Arc Type -~ Arc Type ~ A~

Parameters A~

(?x 0.00

(:v 0.00

C‘ 0.00
x

C‘ 0.00
4

(7; 0.00

(7: 0.00

K 0.00

Ilﬂ 0.00°

o Existing Relations. The Existing Relations box provides the

following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the

selected entity. Displays the relations which are possible for

the selected entity.

construction geometry.

Options. For construction. Converts the selected entity to

Parameters. Provides the ability to specify any appropriate

combination of parameters to define your arc if the arc is not
constrained by relations. The available selections are
Center X Coordinate, Center Y Coordinate, Start X
Coordinate, Start Y Coordinate, End X Coordinate, End

Y Coordinate, Radius and Angle.
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Tutorial: Centerpoint Arc 4-1
Create a Centerpoint Arc sketch.
1. Create a New | ] part. Use the default ANSI

N R=42.3
Part template. PR
2. Right-click Front Plane from the ;‘; _,-"f
FeatureManager. This is your Sketch plane. ! A=
3. Click Sketch  from the Context toolbar.
4. Click the Line 7 Sketch tool. Sketch a
horizontal line through the origin as illustrated.
5. Click Centerpoint Arc ** from the N
Consolidated Arc Sketch toolbar. The Arc B
icon is displayed on your mouse pointer.
6. Click a location on the horizontal line left of e
the origin. Do not pick the origin or the
endpoint. _ T_
7. Click a position to the right and up on the A =
horizontal line. Drag to set the angle and the
radius of the arc. Release the mouse button to place the arc.
View the Arc PropertyManager and the coordinates.
8. Click OK ¥ from the Arc PropertyManager.
9. Rebuild ¥ the model. Close the model.
. S ER S @
Tangent Arc Sketch Entity e @
The Tangent Arc Sketch entity §’ tool provides the ability to create |,., &
an arc, which is tangent to a sketch entity. The Tangent Arc Sketch | A
entity uses the Arc PropertyManager. View the Centerpoint Arc = -
Sketch entity section above for additional information on the Arc @ [0
PropertyManager. @, (000
: IJ_ G 0.00
“¥* You can transition from sketching a line to sketching a ¢, |00
Tangent Arc, and vice versa without selecting the Arc tool from the | ow
Sketch toolbar. Example: Create a line. Click the endpoint of the ¢ [0
line. Move your mouse pointer away. The Preview displays another | < ow
line. Move your mouse pointer back to the selected line endpoint. ke 000°

The Preview displays a tangent arc. Click to place the arc. Move
the mouse pointer away from the arc endpoint. Perform the same
procedure above to continue.
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Tutorial: Tangent Arc 4-1

Design Intent, Sketching and Sketch Entities

Create a Tangent Arc sketch. & Bl & >
1. Create a New [ part. Use the default ANSI Part template. g
. . @3 Part3 (Default<<Default>_Dis
2. Right-click Front Plane from the FeatureManager. History
. el Sensors
3. Click Sketch ‘— from the Context toolbar. [ Design Binder
. / Annotations
4. Click the Line Sketch tool. [E) Equations
Sketch a horizontal line through the Origin. ~F t"raF ®pLL
[»‘ I Front Plane)
6. Click Tangent Arc > from the Consolidated Arc Sketch [l Rig [, 3D Sketch On PI3
toolbar. The Arc icon is displayed on the mouse pointer. 4 on  SectionView

7. Click the left end point of the horizontal line.

8. Drag the mouse pointer upward and to the left for
the desired shape.

9. Click an end point. You created a Tangent Arc. The
Arc PropertyManager is displayed.

10. Right-click Select in the Graphics window to

deselect the Sketch tool.
11. Click OK ¥ from the Arc PropertyManager.

4 A =80PR=41.92

ol

12. Exit the sketch. Close the model. - a
¥ You can select an end point of a line, ellipse,
arc or a spline. The Tangent Arc tool creates both
Normal and Tangent Arcs.
3 Point Arc Sketch Entity
The 3 Point Arc Sketch entity & tool provides the ability to create ?A‘ e 5
an arc by specifying three points: a starting point, an endpoint, anda |,
midpoint. View the Centerpoint Arc Sketch entity section for o ~
additional information on the Arc PropertyManager. @ D Q
Parameters l oint rﬂ
Tutorial: 3 Point Arc 4-1 = I TH
Create a 3Point Arc sketch. 2y
1. Open 3 Point Arc 4-1 from the o B
SOLIDWORKS 2018 folder. O-v- & (|50
2. Edit Sketchl. IORO-ALZZ 3 o
[l .= Centerpoint Arc
K 0.00

g _D Tangent Arc

11 ™ 3 Point Arc

3. Click 3 Point Arc *® from the Consolidated

0.00°

=z

Arc Sketch toolbar.
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4. Click the top point of the vertical line for the start point as
illustrated.
5. Click the right point of the open circle for the
end point as illustrated.
6. Drag the arc downward to set the radius.
7. Click a position for the midpoint of the 3Point A
Arc.
8. Click OK ¥ from the Arc PropertyManager. )
9. Rebuild 8 the model. |
10. Close the model.
Ellipse Sketch Entity
N SERG®
The Ellipse Sketch entity @ tool provides the ability to create a @ Ellipse ®@
complete ellipse. The Ellipse PropertyManager controls the v
properties of a sketched Ellipse or a Partial Ellipse. The Ellipse Existing Relations A
PropertyManager provides the following selections: n
o Existing Relations. The Existing Relations box provides the
following options: @ Under Defined
e Relations. Displays the automatic relations inferenced A; P:X'ams B
during sketching or created manually with the Add .
Relations tool. The callout in the Graphics window is °""°E e -
highlighted when you select a relation in the dialog box. | N
The Information icon in the Existing Relations box a -
displays the sketch status of the selected sketch entity. a .
Example: Under Defined, Fully Defined, etc. 5
e Add Relations. Provides the ability to add relations to the 6 [osssmms

selected entity. Displays the relations which are possible for
the selected entity.

Options. The Options box provides the following selection:
e For construction. Converts the selected entity to construction geometry.

Parameters. Provides the ability to specify any appropriate combination of
parameters to define the ellipse if the ellipse is not constrained by relations. The
available selections are Center X Coordinate, Center Y Coordinate, Start X
Coordinate (only available for a Partial Ellipse), Start Y Coordinate (only available
for a Partial Ellipse), End X Coordinate (only available for a Partial Ellipse), End Y
Coordinate (only available for a Partial Ellipse), Radius 1, Radius 2 and Angle
(only available for a Partial Ellipse).
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Tutorial: Ellipse 4-1
Create an Ellipse sketch.

1. Create a New | ] part. Use the
default ANSI Part template.

2. Right-click Front Plane from the
FeatureManager. This is your
Sketch plane.

Design Intent, Sketching and Sketch Entities

Arim ur
‘@ h:L“%\L Entities Ent
Ellipse
I C: Partial Ellipse
: U Parabola

ﬂ Conic

3. Click Sketch & from the Context toolbar.
4. Click the Ellipse & Sketch tool. The Ellipse icon is

displayed on the mouse pointer.

5. Click the origin in the Graphics window. This is the start

location.

6. Drag and click to set the major axis of the ellipse. The

ellipse PropertyManager is displayed.

7. Drag and click again to set the minor axis of the

ellipse.

Deselect the sketch tool.

8. Right-click Select in the Graphics window.

Add a vertical geometric relation in the sketch.

9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom

vertical point of the Ellipse.

11. Right-click Make Vertical from the Pop-up menu.

12. View the sketch.
13. Close the model.

Partial Ellipse Sketch Entity

The Partial Ellipse Sketch entity % tool provides the ability
to create a partial ellipse or an elliptical arc from a
centerpoint, a start point, and an end point. You used a
similar procedure when you created a Centerpoint Arc. The
Ellipse PropertyManager controls the properties of a
sketched Ellipse or a Partial Ellipse. View the Ellipse
section for additional information on the Ellipse

PropertyManager.
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Parabola Sketch Entity BILERE)

U Parabola @
The Parabola Sketch entity & tool provides the ability to create a |
parabolic curve. The Parabola Sketch entity uses the Parabola Existing Reltions N
PropertyManager. The Parabola PropertyManager provides the L

following selections:

Existing Relations. The Existing Relations box provides the
following options:

@  Under Defined

Add Relations A
o . . . . Qf Fix
e Relations. Displays the automatic relations inferenced
Options A

during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

Options. For construction. Not selected by default. Converts
the selected entity to construction geometry.

Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the
parabola is not constrained by relations. The available
selections are Start X Coordinate, Start Y Coordinate, End
X Coordinate, End Y Coordinate, Center X Coordinate,
Center Y Coordinate, Apex X Coordinate and Apex Y
Coordinate.

D For construction

Parameters ~

[\ -4.29867287
X

[} 2.42903797

.
p o
N
S
o
S

clofcizle|zfz|zlc|zlc|ofc(p|c |

Tutorial: Parabola 4-1 @ %‘ﬂ Entities E
Create a Parabola sketch. (3 Ellipse
1. Create a New | ] part. Use the default ANSI, IPS Part G Partial Ellipse
template. “Na/ Parabola
2. Right-click Front Plane from the FeatureManager. This is M\ Conic
your Sketch plane.
3. Click Sketch {_ from the Context toolbar.

Apply the Parabola Sketch tool.

4.

Click the Parabola \J Sketch tool from the Consolidated
Sketch toolbar. The Parabola icon is displayed on the mouse
pointer.
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5. Click a position in the Graphics window to locate the
focus of your parabola.

6. Drag to enlarge the parabola. The parabola is outlined.

7. Click on the parabola and drag to define the extent of .
the curve. The Parabola PropertyManager is displayed. U

8. Click OK ¥ from the Parabola PropertyManager. L

9. Rebuild @ the model.
10. Close the model.

. . © B4 & E
Conic Sketch Entity ﬁc . ® %M
onic Conic @
. N . < v
The Conic Sketch entity /" tool provides the options Il — .
ablllty tO SketCh COIllC curves driVel’l by DFor construction J:L 2
endpoints and Rho value. Depending on the [ Auto tangency

Rho value, the curve can be elliptical,
parabolic, or hyperbolic. In previous versions of the .
SOLIDWORKS software, you could sketch ellipses and had feadions

@  Under Defined

parabolas. However, you could not sketch ellipses or parabolas by Qel ™
their endpoints, so it was difficult to make them tangent to °'°"°E e tion -
existing geometry. S o

Conic curves can reference existing sketch or model geometry, or
they can be standalone entities. You can dimension the curve with
a driving dimension, and the resulting dimension displays the Rho value. The conic entity
also includes a value for the radius of curvature.

Conic curve sketch that references existing geometry Preview of revolved sketch

Finished model

w1

“¥" Auto Tangency accelerates the process of sketching a conic curve.

When you select this option in the Conic PropertyManager, you set the first and second
endpoints for the conic curve. The Conic tool applies tangent relations at each endpoint
of the curve and selects the top vertex of the curve. This option is helpful when you
reference existing geometry. If you clear this option, you must define the top vertex of
the curve.

Page 4 - 37



Design Intent, Sketching and Sketch Entities SOLIDWORKS® 2018 Reference Guide

The Conic Sketch entity uses the Conic PropertyManager. The
Conic PropertyManager provides the following selections:

o Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.
Example: Under Defined, Fully Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected entity to construction geometry.

e Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the
parabola is not constrained by relations. The available
selections are Start X Coordinate, Start Y Coordinate, End
X Coordinate, End Y Coordinate, Center X Coordinate,
Center Y Coordinate, Apex X Coordinate and Apex Y
Coordinate.

Tutorial: Conic 4-1

Create a Conic sketch.

1. Open Conic 4-1 from the
SOLIDWORKS 2018 folder. The model
contains an arc and spline.

Apply the Conic Sketch tool.

2. Click the Conic N Sketch tool from the
Consolidated Sketch toolbar. The Conic
icon is displayed on the mouse pointer. =

3. Click the first endpoint for the conic
curve as illustrated.

Origin

S ER ¢ @
f\Conic @
i

®  Under Defined

Add Relations ~

Qe Fix

Options o
D For construction

Parameters *Eg

{\ -1.74186466
x

[\ 0.88917173
¥

[3: -7.50618059
x

[‘o 1.48195288
¥

/’\ -6.71074685

x

/’\ 0.19193968
¥

/"xx -6.40632159
/?\' -0.13926786

0.75

<> <> <> €2 <> <> <Y D> D> K>

0.02091983

A ©

@ 'hﬁ% Entities B
@ Ellipse

@; Partial Ellipse
U Parabola

ﬂ Conic

\

= O

N
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4. Drag the pointer to the right so it’s tangent
with the arc. Because the endpoint is attached
to the existing arc sketch, a yellow inferencing BN
line is displayed.

5. Click the second endpoint as illustrated.

6. Drag the mouse pointer upwards. A yellow
inferencing line is displayed tangent to the L
spline sketch.

7. Drag the mouse pointer out to the intersection
of the two yellow inferencing lines. You can
snap to the intersection of both inference lines
to choose the top vertex of the conic curve.

8. Click at the intersection of both inferencing — N
lines to set the top vertex of the conic curve. A
By selecting the intersection of both
inferencing lines, you ensure that the conic
curve is tangent at both endpoints.

9. Drag the pointer to the left until the Rho l
value is 0.75. As you move the pointer, the
conic curve's Rho value changes.

10. Click to set the Rho value to 0.75. Reference = -

. . ] _-_-———_-—-\‘EI

points are displayed for the curve's shoulder -
and top vertex. Tangent relations are created W

between the curve and the original sketches.

11. Click OK ¥ from the Conic
PropertyManager.

&
12. Rebuild 8 the model. T
13. Close the model.

Conic surfaces are very useful for precision
flowing (aerodynamic) shapes. It is best to have
no more than one singular point on a surface. The
midline curve is usually shared by the top and
bottom fuselage shape surfaces.

Rho is the squareness for conic, and translates into

the squareness of the surface. In theory at 1.0 itis a
dead sharp corner, 0.8 is a very modern squarish
corner, 0.6 is most useful for airplane fuselages, 0.4
looks like an ellipse, and 0.1 is a slanted ellipse section
that tends toward a line between the end points.
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Spline Sketch Entity G ERC@

(U spline @)
v

The Spline Sketch entity »’ tool provides the ability to create a
profile that utilizes a complex curve. This complex curve is called ~ [Pting Relations

a Spline, (Non-uniform Rational B-Spline or NURB). =
Create a spline with control points. With spline control points, you | & | e veined
Can. [Add Relations "~
e Use spline points as handles to pull the spline into the shape & i
you want. Optiens ~
|:| For construction
e Add dimensions between spline points or between spline [ show cunvature

Maintain internal
o
continuity

points and other entities.

Parameters 2

Moo

The 2D Spline PropertyManager provides the following selections: | g,

e Existing Relations. The Existing Relations box provides the g
following options: T

e Add relations to spline points.

Qlsfcisla|®

«  1.1890979
e Relations. Displays the automatic relations inferenced

during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box Reset All Handles .
displays the sketch status of the selected sketch entity.

Example: Under Defined, Fully Defined, etc.

é 54.80692691°
D Tangent driving

Reset This Handle

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.

e Options. The Options box provides the following selection: EERE
e For construction. Not selected by default. Converts the & Curvaturs Scale @
selected entity to construction geometry. v
Scale ~
e Show Curvature. Not selected by default. Provides the —
ability to control the Scale and Density of the curvature. 25 -
Displays the Curvature of the spline in the Graphics . -
window. penay
e -
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Maintain Internal Continuity. Selected by default. Maintains the spline's
internal curvature. When Maintain Internal Continuity is cleared, the curvature
scales down abruptly.

i o’

e

Raised degree. Available only with splines that include curvature handles at each
end. Raises or lowers the degree of the spline. You can also adjust the degrees by
dragging the handles.

Raised degree

Parameters. Provides the ability to specify the appropriate combination of

parameters. The available parameters are:

Spline Point Number. Highlights your selected spline point in the Graphics
window.

X Coordinate. Specifies the x coordinate of your spline point.
Y Coordinate. Specifies the y coordinate of your spline point.

Radius of Curvature. Controls the radius of curvature at any spline point. This
option is only displayed if you select the Add Curvature Control option from the
Spline toolbar, and add a curvature pointer to the spline.

Curvature. Displays the degree of curvature at the point where the curvature
control was added. This option is only displayed if you add a curvature pointer to
the spline.

Tangent Weightingl. Controls the left tangency vector by modifying the spline’s
curvature at the spline point.

Tangent Weighting 2. Controls the right tangency vector by modifying the
spline’s curvature at the spline point.

Tangent Radial Direction. Controls the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y or Z axis.
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e Tangent Polar Direction. Controls the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

e Tangent Driving. Enables spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

e Reset This Handle. Returns the selected spline handle to the initial state.
e Reset All Handles. Returns the spline handles to their initial state.

e Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If the node you are dragging
results in a spline which is not smooth, re-select the spline to display the
PropertyManager. Click the Relax Spline selection under the Parameters option.
This will re-parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar Spline Tools 1
7 % T
Use the tools located on the Spline toolbar to control 710 = ‘% A

properties of a sketched spline. The Spline toolbar
provides the following tools:

% -
e Add Tangency Control. The Add Tangency Control tool 7 adds a
tangency control handle. Drag the control handle along the spline N v
and position it to control the tangency at the selected point. A

e Add Curvature Control. The Add Curvature Control tool 0 adds
a curvature control handle. Drag the control handle along the spline
and position the control handle to control the spline shape at the
selected point.

e Insert Spline Point. The Insert Spline Point tool r adds a point to
the spline. Drag spline points to reshape the spline.

s
P

You can insert dimensions between the spline points.

o Simplify Spline. The Simplify Spline tool 7% reduces the number
of points in the spline. This function improves the performance in
the model for complex spline curves.

e Fit Spline. The Fit Spline tool - adds a spline based on the
selected sketch entities and edges.
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e Show Spline Handles. The Show Spline Handles tool el displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

e Show Inflection Points. The Show Inflection Points tool R displays all points where
the concavity of a selected spline changes.

o Show Minimum Radius. The Show Minimum Radius tool /™ displays the
measurement of the smallest radius in the selected spline.

e Show Curvature Combs. The Show Curvature Combs tool & displays the scalable
curvature combs which visually enhance the curves of your selected spline.

Tutorial: 2D Spline 4-1

Create a 2D Spline sketch. m # O

1. Create a New [ part. Use the default ANSI, IPS Part \W Spline T
template. AF Style Spline

2. Right-click Right Plane from the FeatureManager. | % Equation Driven Curve

This is your Sketch plane.

3. Click Sketch £ from the Context toolbar.

Apply the Spline Sketch tool.
4. Click the Spline /U Sketch tool. The spline icon is
displayed on the mouse pointer.

5. Create the Spline. This is an open profile. Create a
seven point control spline as illustrated. Do not
select the origin. The Spline PropertyManager is
displayed.

6. Right-click Select on the last control point.
7. Exit the Spline /V tool. l_

8. Click and drag the spline from left to right. Do not
select a control or handle. The spline moves without
changing its shape. <

9. Click OK ¥ from the Spline PropertyManager.

10. Rebuild @ the model. View the results.
11. Close the model.
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AR Spline handles are displayed by default. To hide or display spline handles, click the

Show Spline Handles % tool from the Spline toolbar or click Tools > Spline Tools >
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline sketch handle.
1. Open 2D Spline 4-2 from the SOLIDWORKS 2018 folder.

2. Edit Sketchl.

Use the Smart Dimension tool to
dimension a spline handle. Display the

handles. AWRROLG
3. Click the Spline in the Graphics - N P
window. The Spline ‘ =
PropertyManager is displayed. o
Locate the pointer on the top $ \
handle. The rotate & icon is u =
displayed.
4. Click the top handle tip.
5. Rotate the handle upwards as
illustrated to create a Tangent
Driving.
6. Right-click Smart Dimension £ from the &
Context toolbar.
Create a Tangent Radial dimension. =
7. Click the handle arrow tip.
8. Click the horizontal line. Modify
9. Enter 40deg. ‘[: 2 ? |
10. Set precision to none. e :
11. Click OK ¥ from the Dimension o
PropertyManager. View the results. &
12. Close the model. ==
w1
“¥" For a Tangent Magnitude, select the arrow - R
tip on the handle to add the dimension. - =
; I E . . “-’?%i [.12 (Document) V]
[llustrations may vary depending on your

SOLIDWORKS version and system setup.
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Tutorial: 3D Spline 4-1
Create a 3D Spline Sketch.

1. Create a New | part. Use the default ANSI Part ‘

template.
2. Click Insert > 3D Sketch from the Menu bar menu. — L
Apply the Spline Sketch tool. / Xy -

3. Click the Spline /U Sketch tool.

4. Click a location in the Graphics window to
place the first spline point. Each time you
click a different location, the space handle
is displayed to help you sketch on a
different plane. I L
el 7 XY 3~n
“¥" Press the Tab key to change planes in a
3D Sketch.

5. Click three additional locations as

. . . B
illustrated. The Spline PropertyManager is '
displayed. ‘
6. Right-click Select on the last control point. L L
7. Exit the 3D Sketch. 3DSketchl is created /
and displayed in the FeatureManager. First point

8. Close the sketch.

Last point

Tutorial: 3D Spline 4-2

Edit a 3D spline sketch using the current elements.

1. Open 3D Spline 4-2 from the SOLIDWORKS
2018 folder.

2. Edit 3DSketchl.

3. Click the Spline in the Graphics window. The / *
Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag

method on a control point.

4. Click a spline control point as illustrated and
drag it upward. The Point PropertyManager is
displayed. View the results.
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Modify the Spline shape using the x-, y- and

z- coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for x-, y-, and z- coordinates from
the Point PropertyManager. You modified the
shape of the spline.

Modify the Spline shape using the click and drag
method on a handle.
7. Click a spline handle as illustrated.

8. Drag the selected spline handle to control the
tangency vector by modifying the spline’s
degree of curvature at the spline point. The
Spline PropertyManager is displayed.

Reset the handle to the original location.

9. Click the Reset This Handle option. All values
relative to the selected handle return to their
original value.

Move the spline.

10. Click and drag the spline from left to right. Do
not select a control point. As the spline is
moved, it retains its shape.

11. Click OK ¥ from the Spline
PropertyManager.

12. Exit the 3D Sketch. View the results.
13. Close the model.

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.
1. Open 3D Spline 4-3 from the
SOLIDWORKS 2018 folder.

2. Edit 3DSketchl. f

*

3. Click the spline from the Graphics
window. The Spline PropertyManager is g
displayed.

4. Click the Add Tangency Control 7 tool
from the Spline toolbar.
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5. Drag to place the handle as illustrated.

6. Click a position for the handle. \ e i
7. Click OK ¥ from the Spline
PropertyManager. Pu<g \
8. Exit the 3D Sketch. View the results.
9. Close the model. X, N %
Style Spline

The Style Spline >’ tool provides the ability

to sketch single-span Bézier curves. These curves
let you create smooth and robust surfaces, and
are available in 2D and 3D sketches.

The Style Spline consists of only one span. You
shape its curvature by selecting and dragging
control vertex points. Sketch entities connect the
control vertices which form the control polygon
of the curve.

With the Style Spline tool, you can control the degree and
continuity of the curves. You can inference style splines
for tangency or equal curvature. You can constrain the
points and dimension the curves' sides. These curves also
support mirroring and self-symmetry.

Spline on Surface Entity

The Spline on Surface entity @ tool provides the

ability to sketch splines on various surfaces.

Splines sketched on surfaces include standard

spline attributes, as well as the capabilities to add

and drag points along the surface and to generate a
preview that is automatically smoothed through the

points. N

i

Al spline points are bounded to the surface on
which they are sketched.
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Tutorial: Spline on Surface 4-1

Create a Closed Spline on Surface feature. VR ©
1. Open Spline on Surface 4-1 from the “T® Spline on Surface
SOLIDWORKS 2018 folder. e -

2. Click the top left face as illustrated.

3. Click the Spline on Surface @ Sketch tool. The
spline icon is displayed on the mouse pointer.

4. Create a five point closed spline as illustrated.

5. Click OK ¥ from Spline PropertyManager to
close the sketch tool.

6. Click the Extruded Boss/Base Features tool. The
Boss-Extrude PropertyManager is displayed.

7. Click the left vertical line as illustrated for
Direction 1. Edge<1> is displayed in the
Direction of Extrusion box.

8. Enter 10mm for Depth. i
9. Click OK ¥ from the Boss-
Extrude PropertyManager. & Bose-Extrude ®
Boss-Extrudel is displayed. View o 8BS
the results in the Graphics window.  |som ~
10. Close the model. ,,i,m:iet:h — N

7 Blind v

Splines on surfaces can: o
| E—

e Span multiple faces.

&) 10.0€Depth (Enter a value or |

e Update if model geometry is ] i N

updated (unless the splines are o o
constrained). [ irection 2 v SERC@ >
7

Selected Contours

¢ You can move the points on the @ Spline on Surface 4-1 (Default
spline to different faces by dragging () istory

. . ensors
the points but not by dragging the innotaﬁons

curve ltself. (@ Equations
2% Material <not specified>
lﬂ Front Plane
Iﬂ Top Plane
Iﬂ Right Plane
I_, Origin
< @ Extrude-Thin1
C Sketch1
@ Boss-Extrude1
(30 () 3DSketch1

v
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Intelligence Modeling - Equation Driven
Curve

The Equation Driven Curve %43 tool is a 2D Sketch spline driven
by an equation. This Sketch entity provides the ability to create a
curve by specifying the equations that define the curve.
Equations defining a curve specify y- as a function of x-. You
can use any function that is supported in the Equations dialog
box. See Chapter 18 - Intelligence modeling techniques for
additional information.

The Equation Driven Curve entity uses the Equation Driven
Curve PropertyManager. The PropertyManager provides the
following selections:

e Equation Type. There are equation types available: Explicit
and Parametric.

e Parameters. The Parameters box provides the following
options:

e Equation. Provides the ability to enter an equation as a
function of X-. If you enter an equation that can’t be
resolved, the text color is displayed in red.

e Parameters. Provides the ability to enter the start and
end X value of the equation.

e Transform. Provides the ability to enter the translation
of X-, Y- and angle for the curve.

Tutorial: Equation Driven Curve 4-1

Create an Equation Driven Curve on the Front Plane.

1. Create a New | part. Use the default ANSI, IPS Part
template.

Create a 2D Sketch on the Front Plane.
2. Right-click Front Plane from the FeatureManager.

3. Click Sketeh (_ from the Context toolbar. The Sketch
toolbar is displayed. Front Plane is your Sketch plane.

4. Click the Equation Driven Curve % Sketch tool. The
Equation Driven Curve PropertyManager is displayed. This
tool provides the ability to build intelligences into a part.
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Sﬁ)emfy the equation that defines the sketch. Note: y- is a function DIEIRNE)
oL X-. . .. . “& Equation Driven Curve (2)
5. Click Explicit for Equation Type. v x
6. Enter 3*x*sin(x) as illustrated in the Equation Message ~

bOX_ n Enter an equation in terms of x where

the resulting y values are calculated

7. Enter 0 for the start point as illustrated. accordng o the start value x1 and the
8. Enter 4*pi for the end point. Note: You can fix Equatig)rpﬁ -

the end points of the curve by applying the Fix 1 Bxplicit

O Parametric
tool.
Parameters ~

9. Click OK ¥ from Equation Driven Curve EEe

PropertyManager. View the created curve. 7 | |

Note: click the curve in the Graphics window to Parameters

edit the Parameters of the curve. I X

. . . X, |4pi

10. Click Exit Sketch. View the results.
11. Close the model.
w1

“¥* Use regular mathematical notation and order of operations to write an equation. x;
and x» are for the beginning and end of the curve. Use the transform options at the bottom
of the PropertyManager to move the entire curve in X-, y- or rotation. To specify x=f(y)
instead of y = f(x), use a 90 degree transform.

w 1

‘¥ View the .mp4 provided movies in the book to better understand the potential of the
Equation Driven Curve tool. The first one is Calculating Area of a region bounded by
two curves (secx)”2 and sin x in SOLIDWORKS; the second one is Determine the
Volume of a Function Revolved Around the x Axis in SOLIDWORKS. Both are located in
the SOLIDWORKS 2018 folder.

Curve Through XYZ Points ﬂ e
ST
The Curve Through XYZ Points & feature provides the g e
ability to either type in (using the Curve File dialog box) SN o gz s
or click Browse and import a text file using x-, y-, z- ‘2 e o eerence o
elix an piral

coordinates for points on a curve.

< [ 3

A text file can be generated by any program which

creates columns of numbers. The Curve [a) feature
reacts like a default spline that is fully defined.

Bor | x| Al

CNLAS L&
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Create a curve using the Curve Through XY Z Points tool. Import the x-, y-, z- data.
Verify that the first and last points in the curve file are the same for a closed profile.

w1

“¥" Tt is highly recommended that you insert a few extra points on either end of the
curve to set end conditions or tangency in the Curve File dialog box.

Imported files can have an extension of either *.sldcrv or *.text.
The imported data: x-, y-, z-, must be separated by a space, a comma, or a tab.

Tutorial: Curve Through XYZ points 4-1

Create a curve using the Curve Through XYZ Points tool. Import x-, y-, z- data from a CAM
program. Verify that the first and last points in the curve file are the same for a closed profile.
1. Open Curve Through XYZ points 4-1 from the SOLIDWORKS 2018 folder.

2. Click the Curve Through XYZ Points U tool from the U
Features CommandManager. The Curve File dialog box is CUIVes| | 1nstant3D
displayed.
=[S
Import x-, y-, z- data. Verify that the first and last points in the \_*tf e S P
curve file are the same for a closed profile. | 2 Helix and Spiral
3. Click Browse from the Curve File dialog box.
Curves (*.sldcrv) A
4. Browse to the SOLIDWORKS 2018 folder. l@wesmdm) l
Text Files (*.txt)
5. Set file type to Text Files. =
6. Double-click cam2.text. View the data in the Curve File ::;_CTOOLBOX
dialog box. View the sketch in the Graphics window. -
Review the data points in the dialog box. Y
7. Click OK from the Curve File dialog box.
Curvel is displayed in the FeatureManager.
This curve can now be used in a sketch (fully
defined profile). View the results of the fully
defined sketch using the curve. boint R v y f’
1 50mm Omm (= ave
&. Close the model. 2 2099mm|  088mm C
3 4997mm 1.78mm aq
9. Open Curve Through XYZ points 4-2 from Ry S : —
the SOLIDWORKS 2018 folder to view the 6 | 4982mm|  a54mm c ittt
final model and FeatureManager. i1 sscemml eaamm .
10. Close the model. « ?n S rcv

w1

s See Chapter 18 - Intelligence Modeling
techniques for additional information.
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Curve Through Reference Points T =
s Instant3D
The Curve Through Reference Points B tool provides
the ability to create a curve through points located on 1S

one or more planes. See SOLIDWORKS Help for | 8 split Line

additional information. G Project Curve

R1 Composite Curve

\ ?j Curve Through XYZ Points

ﬂ Curve Through Reference Points
E Helix and Spiral

Point Sketch Entity S ERS@
The Point Sketch entity tool provides the ability to insert points = Point @
in your sketches and drawings. To modify the properties of a v
point, select the point in an active sketch, and edit the properties | existing Relations ~
in the Point PropertyManager. The Point PropertyManager h
provides the following selections:
e Existing Relations. The Existing Relations box provides the O U Ealme
following options: Add Relations ~
e Relations. Displays the automatic relations inferenced Elig
during sketching or created manually with the Add Pa’“““f;gmw -
Relations tool. The callout in the Graphics window is * ”

highlighted when you select a relation in the dialog box. k

The Information icon in the Existing Relations box
displays the sketch status of the selected sketch entity.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for
the selected entity.
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e Parameters. Provides the ability to specify the appropriate combination of parameters
for your point only if the point is not constrained by relations. The available
parameters are:

X Coordinate. Specifies the x coordinate of your point.

Y Coordinate. Specifies the y coordinate of your point.

Centerline Sketch Entity BIEREL

/ Insert Line ®

The Centerline Sketch entity >’ tool provides the ability to use v %

centerlines to create symmetrical sketch elements and revolved

Message ~

features, or as construction geometry. The Centerline sketch T s
entity uses the Insert Line PropertyManager. The Insert Line or sketch a new line.
PropertyManager provides the following selections: Orientation ~
. . . . @As sketched
e Orientation. The Orientation box provides the following O Horizontal
options: O Vertical
. . . . . O Angle
e As sketched. Sketch a line in any direction using the click - ’

. . . ptions ~
and drag method. Using the click-click method, the As For construction
sketched option provides the ability to sketch a line in any [ infinite length
direction, and to continue sketching other lines in any (] Midpoint line

s
i

direction, until you double-click to end your process.

Horizontal. Sketch a horizontal line until you release
your mouse pointer.

Vertical. Sketch a vertical line until you release your
mouse pointer.

Angle. Sketch a line at an angle until you release your
mouse pointer.

The angle is created relative to the horizontal.

e Options. The Options box provides two line types:

w1

For construction. Selected by default. Converts the selected sketch entity to
construction geometry.

Infinite length. Not selected by default. Creates a line of infinite length which
you can later trim in the design process.

Midpoint line. Creates a line that is symmetrical from the midpoint of the line.

“¥" Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a
centerline.
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Text Sketch Entity

The Text Sketch A entity tool provides the ability to sketch text
on the face of a part and extrude or cut the text. Text can be
inserted on any set of continuous curves or edges. This includes
circles or profiles which consist of lines, arcs or splines.

w 1

“¥" Convert the sketch entities to construction geometry if the
curve is a sketch entity, or a set of sketch entities, and your sketch
text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The
Sketch Text PropertyManager provides the following selections:

e Curves. The Curves box provides the following options:

e Select Edges, Curves Segment. Displays the selected
curves, edges, sketches, or sketch segments.

e Text. The Text box provides the following options:

e Text. Displays the entered text along the selected entity in

the Graphics window. If you do not select an entity, the text

is displayed horizontally starting at the origin.
e Bold Style. Bold the selected text.
o Italic Style. Italicize the selected text.
e Rotate Style. Rotate the selected text.

e Left Alignment. Justify text to the left. Only available for
text along an edge, curve or sketch segment.

e Center Alignment. Justify text to the center. Only
available for text along an edge, curve or sketch segment.

e Right Alignment. Justify text to the right. Only available
for text along an edge, curve or sketch segment.

e Full Justify Alignment. Justify text. Only available for text

along an edge, curve or sketch segment.

e Flip. Provides the ability to flip the text.
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e Flip Vertical direction and back. The Flip Vertical option is only available for
text along an edge, curve or sketch segment.

¢ Flip Horizontal direction and back. The Flip Horizontal option is only available
for text along an edge, curve or sketch segment.

e Width Factor. Provides the ability to widen each of your characters evenly by a
specified percentage. Not available when you select the Use document's font
option.

e Spacing. Provides the ability to modify the spacing between each character by a
specified percentage. Not available when your text is fully justified or when you
select the Use document's font option.

e Use document's font. Selected by default. Provides the ability to clear the initial
font and to choose another font by using the Font option button.

e Font. Provides the ability to choose a font size and style from the Font dialog

box.

Tutorial: Text 4-1 * O g kow
Apply text on a curved part. Use the Sketch Text tool. Eg:::es Eg::ir; Offset gp .|
1. Open Text 4-1 from the SOLIDWORKS 2018 folder. N Frtities 77

The Lens Cap is displayed in the Graphics window. Text

|| Sketches text. You can sketch text on

2. Click Front Plane from the FeatureManager. - fact?tsg curves, edges, and sketch
Apply the Text Sketch tool.
3. Click the Text £ Sketch tool. The Sketch Text

PropertyManager is displayed.
4. Click inside the Text box.
5. Type SOLIDWORKS. SOLIDWORKS is displayed

horizontally in the Graphics window starting at the origin

because you do not select an entity.
6. Click inside the Curves option box. Click the front edge

of Base Extrude. Edge<1> is displayed in the Curves

option box. The SOLIDWORKS text is displayed on the

selected edge.
7. Uncheck the Use document font box.
8. Enter 250% in the Spacing box.
9. Click the Font Button. The Choose Font dialog box is

10. Select Arial Black, Regular, Point 14.

displayed.
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11. Click OK from the Choose Font dialog box.

12. Click OK ¥ from the Sketch Text PropertyManager. Sketch7
is created and is displayed in the FeatureManager. Zoom in on
the created text.

13. Close the model.

L
“¥" If the curve is a sketch entity, or a set of sketch entities, and
the sketch text is in the same sketch as the curve, convert the

sketch entities to construction geometry.

Plane Sketch Entity CE R ¢ e
The Plane Sketch entity tool provides the ability for the user to " Sletch Plane @
add Reference entities to a 3D sketch. Why? To facilitate v

Message »

sketching, and to add relations between sketch entities. Once you
. . . . . Select references (planes, sketch
add the plane, you need to activate it to display its properties and [entities, edges, faces or vertices) to

define the sketch plane. Then select the

to create a sketch. The Plane sketch entity uses the Sketch Plane | onstraining reiations to each reference.

PropertyManager. First Reference ~
The Sketch Plane PropertyManager provides the following ©
selections:
Second Reference A

o First Reference. Provides the ability to select Reference ®

entities from the FeatureManager or from the Graphics

window. Select the constraining relations to each reference. e — a

The available relations selection is based on the selected s}

geometry. I

e Reference Entities. Displays the selected sketch entity or
plane as the reference to position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected
geometry.

w1

“¥* The available relations are displayed in the Sketch Plane
PropertyManager under the First, Second and Third Reference.
The relations are based on existing geometry.
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Second Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

¢ Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

Third Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

¢ Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

w 1

‘¥ With existing geometry, add a plane by referencing the entities that are present. Use

any number of references required to achieve the desired results.

Tutorial: Sketch Plane 4-1

Add a 3D Sketch plane. Add a plane using references. Select two
corner points of a 3D sketch. The corner points of the rectangle
reference the position of the 3D sketch plane.

1. Open Sketch Plane 4-1 from the SOLIDWORKS 2018
folder.
2. Edit 3DSketchl from the FeatureManager. CBR@
. il Sketch Plane @
3. Click Tools > Sketch Entities > v ox
Plane. The Sketch Plane Message N
PI‘O eI't Mana er IS dlS la ed == Select references (planes, sketch
p y g p y % [E $ O > entities, edges, fach or vertices) to
- ! i ? define the sketch plane. Then select the
/Q\ Rename a feature or Sketch for @3 Sketch Plane 4-1 (Default<<Default constraining relations to each reference.
clarity. Slowly click the feature or sketch History Firs Reterence -
. Sensors @
name twice and enter the new name _
. . . 4 Annotations
when the old one is highlighted. — e N
gri Material <not specified> s
[1J Front Plane
[:J Top Plane
[:J Righ 1%« Third Reference A~
~ I_. Orig @ o 1 @
Feature (3DSketch1)
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4. Click the top front corner point of the rectangle as /L
illustrated. Point3 is displayed in the First Reference
box.

5. Click the bottom back corner point of the rectangle.
Point4 is displayed in the Second Reference box.

5
6. Click OK ¥ from the Sketch Plane V I

PropertyManager.

7. Rebuild 8 the model. Plane2@3DSketchl is
created and is displayed in the Graphics
window.

8. Close the model.

Route Line Sketch Entity

The Route Line Sketch entity tool provides e [ @ Ble/@ >

.y . . * Route Line
the ability to insert a Route line between ILL o

. . oute Line
faces, circular edges, straight edges, or Adds a route line that connects e N
planar faces. The Route Line Sketch entity is | Shaeen ~7 "% [ o
active when you:
. Options ~
e Create an Explode Line Sketch. [ Reverse
Alternate Path

e Edit an Explode Line Sketch. [ Along X1z

e Select the Route Line tool in a 3D sketch.

The Exploded Line Sketch tool @ is a 3D sketch added to an
Exploded View in an assembly. The explode lines indicate the
relationship between components in the assembly.

The Route Line Sketch entity @* uses the Route Line
PropertyManager. The Route Line PropertyManager provides the
following selections:

e Items To Connect. The Items To Connect box provides the following option:

e Reference entities. Displays the selected circular edges, faces, straight edges or
planar faces to connect with your created route line.

e Options. The Options box provides the following selections:

e Reverse. Reverses the direction of your route line. A preview arrow is displayed
in the direction of the route line.

e Alternate Path. Displays an alternate possible path for the route line.

e Along XYZ. Creates a path parallel to the X, Y and Z axis directions.
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w1

‘¥ (Clear the Along XYZ option to use the shortest route.

Tutorial: Route Line 4-1 s Y ®
. . . X\F;iZwe Instant3D Upddalek . Takf1 Larg(—;\AAs;embly
Create an Explode Line sketch using the Route Line Sketch Speedpak Snapshot  Mode
entity. | @7 Exploded View
. Qj“? Explode Line Sketch
1. Open the Route Line 4-1 assembly from the e R s E————

9

SOLIDWORKS 2018 folder. The assembly is

displayed in an Exploded view.

Click the Explode Line Sketch %" tool from the

Assembly toolbar. The Route Line PropertyManager

is displayed. ®

Click the inside face of Cut-Extrudel of Shaft- [Cut-Extruded of Shaft-Collar<1>
Collar<1>. The direction arrow points towards the

back. If required, check the Reverse direction box.

Face<1> @Shaft-Collar-1 is displayed in the Items To

Connect box.

P

Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<1>
component. Face<2>@Flatbar-1 is
displayed in the Items To Connect box.
The arrow points towards the right.

Click the inside face of Cut-Extrude5 of
RodClevis<1>. Face<3>@AirCylinder-1is
displayed in the Items To Connect box.
The arrow points towards the back.

Click the inside face of the second Cut-
Extrude5 feature of RodClevis<l>.
Face<4>@ AirCylinder-1 is displayed in
the Items To Connect box.

Click the inside face of the top hole of
Cut-Extrudel of the Flatbar<2>
component. Face<2>@Flatbar-2 is
displayed in the Items To Connect box.
The arrow points towards the back.
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Click the inside face of Cut-Extrudel of
SHAFT-COLLAR<2>. The direction
arrow points towards the back. Face<1>
@Shaft-Collar<2> is displayed in the
Items To Connect box.

Click OK ¢ from the Route Line
PropertyManager. View the created
Route Line.

10. Click OK ¥ from the PropertyManager

to return to the FeatureManager.

Fit the model to the Graphics window.

Display an Isometric view.

11. Press the f key to fit the
model to the Graphics
window.

12. Click Isometric view.
View the results.

13. Close the model.

A SOLIDWORKS
provides the ability to create
a Bill of Materials (BOM) in
an assembly. The BOM is
displayed in the Tables folder of the FeatureManager. See the
Assembly section for additional information.

¥ Inan assembly exploded view, you can create
explode route lines automatically for selected
components by using the Smart Explode Lines

PropertyManager.

Tutorial: Route Line 4-2

Edit an Explode Line Sketch.
1. Open Route Line 4-2 from the SOLIDWORKS 2018

SOLIDWORKS® 2018 Reference Guide

S ER @

&° Route Line

v «H

Items To Connect

T |Face<1>@Shaft-Collar-1
Face<2>@Flatbar-1
Face<3>@AirCylinder-1/RodCli
Face<4>@AirCylinder-1/RodCle
Face<2>@Flatbar-2

Face<1>@Shaft-Collar-2

@

Options
I:‘ Reverse
Alternate Path
A\ong XYZ

FTE R [S[@]

folder. The Route Line 4-2 Assembly
FeatureManager is displayed.

2. Click the ConfigurationManager tab. N
Expand Default. Right-click ExplView1 from the
ConfigurationManager.

4. Click Explode. View the results in the Graphics

window. Expand ExplViewl.

Configurations

< @ Route Line 4-2 Configuratiol
N " Default [ Route Line

4

| Er(plode

Lo
Animate explode

x Delete

Comment
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Edit the Explode Line Sketch.
5. Right-click 3DExplodel from the
ConfigurationManager.

6. Click Edit Sketch.
7. Display a Top view.

==

8. Click Centerline o from the Sketch @ Y E
toolbar. The Insert Line PropertyManager is L]

displayed.

9. Click the endpoints of the Route Line as
illustrated.

Create a new path.
10. Click a point to the right of the Route Line
endpoint and over the top of the axle.

11. Click a point below the axle as illustrated.

12. Click a point to the left of the axle over the Flatbar.
13. Click a point below the Flatbar.

14. Click a point above the SHAFT-COLLAR.

15. Click a point below the Shaft-Collar.

Deselect the active Sketch tool.
16. Right-click Select in the Graphics window.

17. Rebuild 8 the
model. View the
results.

18. Return to the
FeatureManager
design tree.

19. Close the model.
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Belt/Chain Sketch Entity g ERG@
This option provides the ability to create layout sketches for . pet/Chaln .
pulleys or sprocket mechanisms. The Belt/Chain feature
simulates a cable-pulley mechanism. The Belt/Chain entity uses |t -
the Belt/Chain PrOpertyManager, members around which the belt will
" pass
_/QC . . . Belt Members A
In the past, it was difficult using SOLIDWORKS to o
effectively model components such as cables, chains, and timing
belts due to their flexible motion. The shapes of these items i
could change over time. This made it difficult to examine the I
way a belt would interact with two or more pulleys, or a cable pa IR,
system shifts a lever, or crank with a solid assembly model. S
roperties A
The Belt/Chain PropertyManager provides the following Belt Length:
selections: ?D”V‘”g
e Belt Members. The Belt Members box provides the [ use belt thickness
following options: [ Engage beit
e Pulley Components. Displays the selected arcs or
circles for the pulley components.
e Up arrow. Moves the selected pulley component
upwards in the displayed order.
e Down arrow. Moves the selected pulley component @®
downward in the displayed order. @ L
o Flip belt side. Changes the side on which the belt is
located in the pulley system. @
e Properties. The Properties box provides the ability to “
define the following belt conditions:
e Driving. Cleared by default. Provides the ability to
calculate the length of your belt. When checked, enter @®
a value if you do not want the system to calculate _ @ L
your belt length. Based on the constraints, one or :
more of the components may move to adjust for the .
length of the belt.

-

e Use belt thickness. Specifies the thickness value of
the belt.
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e Engage belt. Selected by default. Disengages the belt mechanism.

[

w1

» Only circle entities in a block can be selected for a belt member.

g ERl¢l@
B I Oc ks & Make Block @
Blocks are a grouping of single or multiple sketch entities. In v X
SOLIDWORKS, the origin of the block is aligned to the Block Entities ~

orientation of the sketch entity. Previously, blocks inherited their
origin location from the Parent sketch. Additional enhancements | =
to BlOCkS are: Insertion Point kel
O Layout Sketch Block

Drag Manipulator on-screen to
position insertion point.

e Modeling pulleys and chain sprockets.

e Modeling cam mechanisms.

Blocks are used in the Belt/Chain sketch entity. You can create blocks from a single
entity or multiple sketch entities.

Why should you use Blocks? Blocks enable you to:

e C(Create layout sketches using the minimum of dimensions and sketch relations.
e Freeze a subset of sketch entities in a sketch to control as a single entity.

e Manage complicated sketches.

e [Edit all instances of a block simultaneously.
w1

‘¥* Use blocks in drawings to conserve drawing items such as standard label positions,
notes, etc. See SOLIDWORKS Help for additional information.

Blocks toolbar Blocks
L o) €] el 20
The Blocks toolbar controls blocks in sketching. The A AL -

Blocks toolbar provides the following tools:
e Make Block. The Make Block 4l tool provides the ability to create a new block.

e Edit Block. The Edit Block * tool provides the ability to add or remove sketch
entities and to modify dimensions and relations in your sketch.

e Insert Block. The Insert Block = tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

e Add/Remove. The Add/Remove 2 tool provides the ability to add or remove sketch
entities to or from your block.
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e Rebuild. The Rebuild B tool provides the ability to update the parent sketches
affected by your block changes.

e Saves Block. The Saves Block tool provides the ability to save the block to a file.
Adds an .sldblk extension.

o Explode Block. The Explode Block 5 tool provides the ability to explode the
selected block.

e Belt/Chain. The Belt/Chain & tool provides the ability to insert a belt.

w1

is Exploding a single instance of the block only affects that instance of the block.

Tutorial: Block 4-1

Create a Block using the Blocks toolbar.
1. Create a New [ part. Use the default ANSI Part L
template.
2. Click Top Plane from the FeatureManager. This is your
Sketch plane.
3. Sketch a closed sketch using sketch entities as illustrated.
The sketch consists of five lines. l‘
4. Click Make Block from the Block toolbar or click DA
Tools > Blocks > Make. The Make Block
. . E Make Block ®
PropertyManager is displayed. .
5. Box-select the sketch entities from the %ﬂ[mes ~
Graphics window. The selected sketch Linel
entities are displayed in the Block e
Entities box. & Bl @ 5| |tnes
Line5
6. Expand the Insertion Point box. Note gpam Detautte Defacts D
the location of the insertion point. (&l History | [ insertion Point ~
. @? Sensors I:‘ Layout Sketch Block
7. Clle OK fI‘Ol’l’l the Make BlOCk » Annotations Drag Manipulator on-screen to
PropertyManager. Block1-1 is displayed | [zequatons I TEEE I
in the FeatureManager' E}T-T Material <not specified>
|/} Front Plane
8. Rebuild 8 the model. () Top Plane
[1‘ Right Plane
9. Close the model. 1, origin
+ () Sketch1
Block1-1
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w1

‘¥* Create a block for a single or combination of multiple
Sketch entities. Saving each block individually provides you
with extensive design flexibility.

Tutorial: Belt-chain 4-1

Use the Belt/Chain Sketch entity function. Create a pulley sketch.

1. Open Belt-chain 4-1 from the SOLIDWORKS 2018 folder.
View the three created blocks in the Belt-chain
FeatureManager.

2. Edit Sketchl from the FeatureManager.

Click Tools > Sketch Entities > Belt/Chain. The
Belt/Chain PropertyManager is displayed.

4. Select the three circles from left to right. The select
circles are displayed in the Belt

Members dialog box. EIEAEE
.. Belt/Chain @
5. Check the Driving box. v x
6. Enter 460mm for Belt Length. Messoe e
Select the circle or arc to define belt
7. Check the Use belt thickness box. | =" feeet
8. Enter 20mm for belt thickness. Belt Members : -
| Y s
9. Click OK % from the Belt/Chain | 1

PropertyManager. n

10. Expand Sketchl. Beltl is created | 2  ripberside

and is displayed in the Properties ~
FeatureManager. The calculated pet L‘D“r:‘_vmg

belt length was larger than the belt Joonm 2
length entered in the [ se belt thickness
PropertyManager. The system 000mm |7
moved the entities to correct for E4Engage bet

the entered 460mm belt length.

11. Rebuild (] the model. View the results.
12. Close the model.

w1

AR View SOLIDWORKS Help for additional information.

The Select Chain command has been enhanced to allow you
to select construction entities. See SOLIDWORKS Help for
additional information.
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Reuse an existing 2D Sketch

You can use the same sketch to create different features. To create different features with
the same sketch:

Create a sketch.

Create a feature from the sketch.

In the FeatureManager design tree, select the same sketch used to create the first

feature.

Create a second feature from the sketch.

In the FeatureManager design tree, a sketch that is shared by multiple features is

identified by the Shared = icon or by Shared =2 icon for a selected contour.

w1

“¥* Add additional sketches as required to create the features. For example, if one
feature is an extrude and the other feature is a revolve use the same sketch for both
features, but add a centerline to create the revolve.

Tutorial: Shared Sketch 4-1
Create an Extrude Thinl feature with a shared sketch.

1.
2.

AN AN S

10.

11.

Open Shared Sketch 4-1 from the SOLIDWORKS 2018 folder.

Click Sketch1 from the FeatureManager. View the sketch in the
Graphics window.

Click Extruded Boss/Base @] from the Feature toolbar.
Select Mid Plane for End Condition in Direction 1.
Enter 16.00mm for Depth.

Check the Thin Feature
dialog box.

Enter 4.50mm for
Thickness.

Click the Reverse
Direction button.

Click inside the Selected
Contours dialog box.

Click the circumference
of the large circle in the Graphics window.

Click OK ¢ from the PropertyManager.
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12. Expand Extrude-Thinl in the
FeatureManager. View the
Shared sketch.

13. Close the model.

I_. Origin
v @ ExtrudeT
fg,, Sketchf
N @ Extrude-ThinT
fé@,, Sketch

Summary

In this chapter, you learned about the available tools to incorporate Design Intent into a
sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D Sketching and how to
recognize various Sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found and Invalid Solution Found along with identifying the correct Reference
plane.

You reviewed the following Sketch Entities: Line, Corner Rectangle, Center Rectangle,
3 Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Conic, Spline, Style Spline, Spline on Surface, Equation Driven Curve, Point,
Centerline, Text, Plane, Route line and Belt/Chain.

You utilized and addressed the following toolbars: Block toolbar and Spline toolbar and
applied the Instant3D tool.

Fully define all sketches in the model. However, there are times when this is not
practical, generally when using the spline tool to create a freeform shape.

Use Construction geometry to assist in creating your sketch entities and geometry that are
ultimately incorporated into the part. Construction geometry is ignored when the sketch is
used to create a feature. Construction geometry uses the same line style as a centerline.

[

* Press the Tab key to change planes in a 3D Sketch.

- s
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You can transition from sketching a line to sketching a Tangent Arc, and vice versa,
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.

Rename a feature or sketch for clarity. Slowly click the feature or sketch name twice and
enter the new name when the old one is highlighted.

A The plane or face you select for the Base sketch determines the orientation of the
part.

w1
“¥" The PropertyManager remembers its last used state.
Chapter 5 provides a comprehensive understanding of the available Sketch tools,

Geometric relations, Dimensions/Relations tools and the DimXpertManager in
SOLIDWORKS.
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